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Survey - gain an overview

System structure of AC500/S500-FBP

The principle system structure is shown in the following figure:

AC500
External CPU S500-FBP 1/0Os
couplers + (max. 7 modules)
(max. 4) internal
couplers
S500-FBP
DC505-FBP S500-FBP 1/Os
(7 modules max.
with a maximum of
4 analog modules)
Explanation

The following electronic modules are the basic components of the AC500 system:

e CPUs of three different performance classes
e Couplers for various bus systems: Fieldbus systems PROFIBUS DP, CANopen, DeviceNet; Ethernet
couplers.

Central expansion: One CPU supports direct connection of up to seven S500 FBP system 1/O devices.

Decentralized expansion: Using the DC505 FBP interface module (for fieldbus systems PROFIBUS DP,
CANopen, DeviceNet, Modbus RTU), up to seven S500 FBP system I/O devices can be connected (with
a maximum of four analog modules).

Mechanical mounting of the electronic modules is done using CPU terminal bases (for the CPU and the
couplers) and I/O terminal units (for the 1/0 modules), designed for snap-on mounting on a DIN rail or for
screw-mounting on a mounting panel.
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AC500 system overview

AC500 is a complex state-of-the-art system providing extensive automation potential for your plant.

Figure: AC500 system

The following pages provide a summary of all devices available for the AC500 system. For detailed
information about the individual devices please refer to the respective hardware description.
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Overview of available CPUs

Type Order number Description

PM571 1SAP 130 100 R0O100 PM571, CPU 64kB, 24 V DC, Memory Card Slot, 2x RS-
232/485 (Programming, MODBUS/CS31), 1x FBP, Display

PM571-ETH 1SAP 130 100 R0170 PM571-ETH, CPU 64kB, 24 V DC, Memory Card Slot, 2x
RS-232/485 (Programming, MODBUS/CS31), 1x FBP,
Display, integrated Ethernet TCP/IP

PM581 1SAP 140 100 R0O100 PM581, CPU 256kB, 24 V DC, Memory Card Slot, 2x RS-
232/485 (Programming, MODBUS/CS31), 1x FBP, Display

PM581- 1SAP 140 100 R0160 PM581-ARCNET, CPU, memory 256 kB, 24 V DC,

ARCNET Memory Card Slot, interfaces 2 x RS-232/485
(programming, Modbus/CS31), 1 x FBP, Display,
integrated coupler ARCNET

PM581-ETH 1SAP 140 100 R0170 PM581-ETH, CPU 256kB, 24 V DC, Memory Card Slot, 2x
RS-232/485 (Programming, MODBUS/CS31), 1x FBP,
Display, with integrated Ethernet TCP/IP coupler

PM582 1SAP 140 200 R0100 PM582, CPU, memory 512 kB, 24 V DC, Memory Card
Slot, interfaces 2 x RS-232/485 (programming,
Modbus/CS31), 1 x FBP, Display

PM582-ETH 1SAP 140 200 R0170 PM582-ETH, CPU, memory 512 kB, 24 V DC, Memory
Card Slot, interfaces 2 x RS-232/485
(programming, Modbus/CS31), 1 x FBP, Display,
integrated coupler Ethernet TCP/IP

PM591 1SAP 150 100 R0100 PM591, CPU 4MB, 24 V DC, Memory Card slot, 2x RS-
232/485 (Programming, MODBUS/CS31), 1x FBP, Display

PM591- 1SAP 150 100 R0160 PM591-ARCNET, CPU, memory 4 MB, 24 V DC, Memory

ARCNET Card Slot, interfaces 2 x RS-232/485 (programming,
Modbus/CS31), 1 x FBP, Display, integrated coupler
ARCNET

PM591-ETH 1SAP 150 100 R0170 PM591-ETH, CPU 4MB, 24 V DC, Memory Card Slot, 2x

RS-232/485 (Programming, MODBUS/CS31), 1x FBP,
Display, with integrated Ethernet TCP/IP Coupler

Overview of available couplers

Type Order number Description

CM572-DP 1SAP 170 200 R0001 CM572-DP, Communication Module PROFIBUS DP
Master 12 Mb/s

CM575-DN 1SAP 170 500 R0O001 CM575-DN, Communication Module DeviceNet Master

CM577-ETH 1SAP 170 700 RO0O1 CM577-ETH, Communication Module, Ethernet TCP/IP,
with integrated 2-port switch

CM578-CN 1SAP 170 800 R0001 CM578-CN, Communication Module, CANopen Master
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Overview of available CPU terminal bases

Type Order number Description

TB511- 1SAP 111 100 R0160 TB511-ARCNET, CPU Terminal Base AC500, 1x CPU

ARCNET Slot, 1x Coupler Slot, ARCNET COAX Connector

TB511-ETH 1SAP 111 100 R0170 TB511-ETH, CPU Terminal Base AC500, 1x CPU Slot, 1x
Coupler Slot, Ethernet RJ45 Connector

TB521- 1SAP 112 100 R0160 TB521-ARCNET, Terminal Base AC500, 1x CPU Slot, 2x

ARCNET Coupler Slots, ARCNET COAX Connector

TB521-ETH 1SAP 112 100 R0170 TB521-ETH, CPU Terminal Base AC500, 1x CPU Slot, 2x
Coupler Slots, Ethernet RJ45 Connector

TB541-ETH 1SAP 114 100 R0170 TB541-ETH, CPU Terminal Base AC500, 1x CPU Slot, 4x
Coupler Slots, Ethernet RJ45 Connector

Overview of available I/O modules

Type Order Number Description

DI524 1SAP 240 000 RO0O1 DI524, Digital Input Module, 32 DI, 24 V DC, 1-wire

DC522 1SAP 240 600 R0O0O1 DC522, Digital input/output module, 16 DC, 24 V DC/ 0.5
A, 2-wire

DC523 1SAP 240 500 R0O0O1 DC523, Digital input/output module, 24 DC, 24 V DC/ 0.5
A, 1-wire

DC532 1SAP 240 100 R0O001 DC532, Digital Input/Output Module, 16 DI/ 16 DC, 24 V
DC/0.5A, 1-wire

DX522 1SAP 245 200 R0001 DX522, Digital Input/Output Module, 8 DI 24 V DC, 8 DO
Relay, 2-wire

DX531 1SAP 245 000 R0O001 DX531, Digital Input/Output Module, 8 DI, 230 V AC, 4 DO
Relay, 2-wire

Al523 1SAP 250 300 R0O001 Al523, Analog input module, 16 Al, U/I/Pt100, 12 Bit + sign,
2-wires

AO523 1SAP 250 200 R0001 AO523, Analog output module, 16 AO, U/I, 12 Bit + sign, 2-
wires

AX521 1SAP 250 100 R0O0O1 AX521, Analog input/output module, 4 Al / 4 AO, U/I/Pt100,
12 Bit + sign, 2-wires

AX522 1SAP 250 000 R0O001 AX522, Analog Input/Output Module, 8 Al / 8 AO,
U/I/Pt100, 12 Bit + sign, 2-wire

Overview of available terminal units

Type Order Number Description

TU515 1SAP 212 200 R0001 TU515, 1/O Terminal Unit, 24 V DC, Screw Terminals

TU516 1SAP 212 000 RO0O1 TU516, I/0 Terminal Unit, 24 V DC, Spring Terminals

TU531 1SAP 217 200 RO0O1 TU531, I/O Terminal Unit, 230 V AC, Relay, Screw
Terminals

TU532 1SAP 217 000 RO0O1 TU532, 1/0O Terminal Unit, 230 V AC, Relay, Spring
Terminals

TU551-CS31 1SAP 210 600 R0O001 TU551-CS31, Bus-I/O Terminal Unit, 24 V DC, Screw
Terminals

TU552-CS31 1SAP 210 400 RO0O1 TU552-CS31, Bus-I/0 Terminal Unit, 24 V DC, Spring
Terminals
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Overview of available FBP interface modules

Type Order Number Description

DC505-FBP 1SAP 220 000 R0001 DC505-FBP, FBP-Interface Module, 8 DI /8 DC, 24 V DC /
0,5 A, 1-wire

DC551-CS31 1SAP 220 500 R0001 DC551-CS31, Digital Input/Output-Bus Module, 8DI / 16DC
24V DC/0,5A, 1-wire

Overview of available FBP terminal units

Type Order Number Description
TU505 1SAP 210 200 R0O0O01 TUS505, FBP Terminal Unit, Screw Terminals
TU506 1SAP 210 000 RO001 TU506, FBP Terminal Unit, Spring Terminals

Overview of available FieldBusPlugs and accessories

Type Order number Description

PDP22-FBP.025 1SAJ 2401 00 R1003 PDP22-FBP.025 PROFIBUS DP-V0/V1-FBP 0.25 m,
modular (FieldBusPlug)

PDP22-FBP.050 1SAJ 2401 00 R1005 PDP22-FBP.050 PROFIBUS DP-V0/V1-FBP 0.5 m,
modular (FieldBusPlug)

PDP22-FBP.100 1SAJ 2401 00 R1010 PDP22-FBP.100 PROFIBUS DP-V0/V1-FBP 1 m,
modular (FieldBusPlug)

PDP22-FBP.200 1SAJ 2401 00 R1020 PDP22-FBP.200 PROFIBUS DP-V0/V1-FBP 2 m,
modular (FieldBusPlug)

PDP22-FBP.500

1SAJ 2401 00 R1050

PDP22-FBP.500 PROFIBUS DP-V0/V1-FBP 5 m,
modular (FieldBusPlug)

PDV11-FBP.0

1SAJ 924 008 R0O001

Feeding connector 24 V DC, Code B-A

PDV12-FBP.0

1SAJ 924 011 R0O0O1

Feeding connector 24 V DC, Code A-A

PDA11-FBP.050

1SAJ 924 009 RO005

Adapter M12-Dsub9-M12, cable length 0.50 m

PDA12-FBP.050

1SAJ 924 010 R0O005

Adapter M12-Dsub9-M12, cable length 2 x 0.50 m

PDR11-FBP.150

1SAJ 924 007 R0O0O1

Terminating resistor 150 Ohm

Overview of available accessories

Type Order Number Description

TA521 1SAP 180 300 R0001 TA521, Lithium Battery

MC502 1SAP 180 100 R0001 MC502, SD Memory Card 128 MB

TK501 1SAP 180 200 R0001 TK501, Programming Cable, D-Sub / D-Sub

TK502 1SAP 180 200 R0101 TK502, Programming Cable, Terminal Block / D-Sub

TA523 1SAP 180 500 R0O001 TA523, Pluggable Marker Holder (10 pcs)

TA524 1SAP 180 600 R0O001 TA524, Dummy Coupler Module

TA525 1SAP 180 700 R0O001 TA525, Set of 10 white Plastic Markers

TA526 1SAP 180 700 R2001 TA526, Wall mounting accessory, 10 pcs

PS501-PROG 1SAP 190 100 RO0O1 PS501-PROG, Control Builder AC500, Programming
Software German / English / French (CD-ROM incl.
Online Help and PDF Docs)
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Bus systems overview

Bus System | Short information/ Web Links / Block Libraries

ARCNET www.arcnet.com ARCNET Trade Association, USA; -> Literature -> Other Puplications
-> ARCNET Tutorial and Product Guide

CANopen www.can-cia.org

DeviceNet www.odva.org -> DEVICENET

Ethernet www.ethermanage.com
The Ethernet Library -> see ‘Function Block Libraries AC500’

Modbus www.modbus.org

PROFIBUS www.profibus.com -> Web Based Training
The PROFIBUS DP Library -> see ‘Function Block Libraries AC500’

G1 Introduction to AC500 1-8 AC500 / Issued: 07.2006



Brief information about ARCNET

ARCNET (Attached Resource Computer NETwork)

ARCNET is an open, multi-purpose field bus solution with real-time capability. It can be used for multi-
master networking and for programming the AC500 and AC31 controller series, but also for connecting
additional ARCNET subscribers, e.g. PCs via an appropriate interface card (see catalog).

Topology

ARCNET is one of the few networks that can be operated in every conceivable topology. Options include
bus, star, or tree topologies, or mixtures of these. This means that ARCNET can be used for a broad
field of different applications.

Bus assignments
ARCNET operates on the token-passing procedure, where each subscriber has equal rights.

Configuration mechanisms

ARCNET subscribers can freely join and leave during an active runtime session. The system will
automatically configure the available user database.

Security mechanisms

A 16-bit CRC is appended to every data packet, and checked by the recipient. If the token is lost, a
reconfiguration routine will be initiated, and the network will automatically be restructured. Additionally,
diagnostic registers are available.

Physical characteristics

ABB recommends coaxial cables as transmission medium, for direct connection to the CPU. But also
twisted-pair cables or (glass, plastic) fiber-optic cables can be connected via bus converters. The line
lengths that can be achieved without any intermediate amplifiers depend not only on the used medium,
but also on the selected baud rate and the number of subscribers. The ranges per segment vary from
approximately 120 m for a simple two-wire bus, up to 3 km for fiber-optics, in each case at 2.5 MBit/s. By
providing appropriate hubs, different topologies and transmission media can be combined with each
other and the transmission distance can be increased. The coaxial cables used are a type with 93 Ohm,
e.g. RG 62. The permissible twisted-pair cables are specified in IEEE 802.3i-1990. At 2.5 MBit/s and with
coaxial cables, for example, the maximum length of a bus segment is 300 m with eight subscribers and
without a hub. With twisted-pair cables, under the same conditions, a maximum length of approximately
120 m can be achieved. The maximum transmis-sion length depends on the number of connected
subscribers. With coaxial cables, a maximum of 16 km can be achieved; with twisted-pair cables
approximately 6 km, in each case at 2.5 MBit/s. The fiber-optic link provides the highest degree of
interference immunity. With glass fiber-optics, distances of up to 3 km are possible at 2.5 MBit/s; with
plastic fiber-optic cables only small distances of up to approximately 100 m. The baud rate plays no
significant role in fiber-optic cable transmission. Here, the range can as well be extended using hubs.

Diagnostics

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called
using the programming tool.

ARCNET - the functionality at a glance

* Guaranteed collision-free data transmission, guaranteed response times and real-time capability thanks
to token-passing

e Large network dimensions: network length 300 m, with amplifier max. 16 km

* Secure, thanks to checksums in the data packet and handshake protocol between transmitter and
receiver

* Variable network structure: bus, tree and star topologies are possible, plus any desired mixtures of them

* Variable networking media, coaxial cables, twisted-pair cables and fiber-optic cables can be mixed

¢ Automatic subscriber log-on and log-off; the network automatically incorporates new stations in the ring
and cancels them as well

* Master-master access: the subscriber that holds the token is the master. With up to 255 masters at the
same network

* Data transmission rate of max. 2.5 MBit/s

* ARCNET is configured and programmed using the AC500 Control Builder engineering tool
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Brief information about CANopen and DeviceNet

CANopen (Controller Area Network) and DeviceNet

The CANopen protocol was originally developed for the European automotive industry to replace
expensive cabling with an affordable system. Today, it is also used in the field of automation for
transmitting process data between control systems, decentralized 1/0 modules, drives, valves, etc. CAN
features a high level of transmission security, since large portions of the monitoring mechanisms have
been implemented directly in the CAN chip. DeviceNet and CANopen utilize the physical structure and
the data transport mechanisms of CAN (Controller Area Network). The difference lies in the transmission
protocols. DeviceNet and CANopen can be used correspondingly for the AC500 and AC31 controller
series and for field-bus-neutral FBP devices (decentralized 1/0Os and intelligent switching devices), via
the CANopen-FBP plug connector.

Data transmission

Two types of message have been defined: I/O data transfer and direct link. /O data transfer is used for
time-critical process data, while the direct link can be, for example, used for diagnostic messages.

Bus access for subscribers

The connection ID with the lower address has higher priority on the bus. Data is transmitted by the
source, while the sinks (i.e. receivers of the data) have likewise been specified during the configuration
phase.

CANopen

The bus operates on the master/slave principle with one master and up to 127 slaves. A shielded
twisted-pair cable is used, according to ISO 11898. Cable lengths and transmission rates: from max. 40
m at 1 MBit/s to 1000 m at 20 kBit/s.

DeviceNet

The bus operates on the multi-master and/or the master/slave principle, with up to 64 bus subscribers.
Two types of shielded twisted-pair cables are used: trunk cable for the main line and drop cable for the
branch line.

Transmission rate 125 Kbit/s 250 Kbit/s 500 Kbit/s

Max. cable length of 500 m (1610 ft) 250 m (820 ft) 100 m (328 ft)
trunk line
Trunk cable

Max. cable length of 100 m (328 ft) 100 m (328 ft) 100 m (328 ft)
trunk line Drop cable

Max. cable length per 6 m (20 ft) 6 m (20 ft) 6 m (20 ft)
branch line
Trunk cable/Drop
cable

Max. cable length total 156 m (512 ft) 78 m (256 ft) 39 m (128 ft)
branch line
Trunk cable/Drop
cable

Diagnostics

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called
using the programming tool. In addition, the device status is indicated at the communication module by
four LEDs.

G1 Introduction to AC500 1-10 AC500 / Issued: 07.2006



Brief information about CS31 field bus
CS31 (Communication Serial Field Bus, developed by ABB in 1989) for continuity and
migration

CS31 is a proprietary master/slave field bus. It is characterized by simple handling, easy configuration,
and inexpensive installation. The COM1 interface of the AC500 can be configured as a CS31 field bus
master.

Communication
Is handled using polling, i.e. the master sends a request to the slave and then receives the response.
The CS31 operating mode of COM1 is set using the engineering tool.

Topology

Multi-point line, RS485, approved without branch lines. A system consists of one master and up to 31
slaves. The maximum cable length is 500 m, or 2 km with an amplifier. Slaves are primarily
decentralized input/output modules with integrated CS31 bus connection.

Data transmission
Is performed at 187.5 kB/s. Each telegram has an 8-bit CRC appended. The telegrams enable process
data (input/output data) to be written and read.

Transmission medium

Primarily a twisted-pair, shielded cable with terminators. Other transmission media: fiber-optic cables via
a converter (glass fibers max. 3 km, plastic max. 100 m), contact lines, slip rings (bus length max. 50 m)
and data photocells.

Diagnostics

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called
using the programming tool.
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Brief information about Ethernet

Ethernet

Ethernet operates with a data rate of 10 MBit/s and as Fast-Ethernet with 100 MBit/s. Ethernet utilizes
the producer/consumer model. This means that every station possesses equal rights. While it is
transmitting, all other stations listen in and accept the data directed to them. Bus access is regulated by
the CSMA/CD procedure (Carrier-Sense Multiple-Access with Collision Detection), where each station
may autonomously transmit when the bus is free. If a collision occurs, if two stations begin to transmit
simultaneously, both of them will stop transmission and wait for a randomly determined time before they
transmit again. Ethernet defines the Layers 1 (Physical Link) and 2 (Data Link) of the OSI model.

The AC500 supports transmission and reception of data using TCP/IP and/or UDP/IP. Further
application layers can be implemented by subsequent loading. Simultaneous operation of TCP/IP,
UDP/IP and application layer is also assured. The IP, TCP, UDP, ARP, RP, BOOTP, and DHCP
protocols are supported as a standard feature, as application layer Modbus/TCP.

Topology

Star- or ring-shaped using Ethernet hub or switch.

Data transmission

Max. 10 MB/s with 10 Base T and max. 100 MB/s with Fast-Ethernet.

Transmission media

Twisted-pair cables with RJ45 connector. The maximum cable length is 100 m for 100 MB/s.

Diagnostics

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called
using the programming tool. In addition, the device status is indicated at the communication module by
four LEDs.
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Brief information about Modbus

Modbus® RTU (developed by Modicon in 1979)

Modbus® RTU is an open master/slave protocol, and can be easily implemented on serial interfaces.
Numerous automation systems have Modbus® RTU interfaces as standard or optional features, and are
thus easily able to communicate with the AC500 via its integrated COM1 and COM2 interfaces (RS232
or RS485). The Modbus® is used not only in industrial applications, but also in building installations, in
energy optimization systems, for long-distance data transmission and for linking up operator panels.

Communication

By polling, i.e. the master transmits a request to the slave and then receives the response. Both
interfaces COM1 and COM2 can operate simultaneously as Modbus interfaces. The Modbus operating
mode of an interface is set using the engineering tool.

Topology

Point-to-point via RS232 or multi-point via RS485. With RS232, a maximum of one master and one slave
is possible, while with RS485 one master and a maximum of 31 slaves can be operated. The maximum
cable length is 15 m with RS232 and 1.2 km with RS485.

Data transfer

Max. 187.5 kB/s. Each telegram has a 16-bit CRC appended. The telegrams permit process data
(input/output data) to be written and read, either individually or in groups. The data are packed in the
RTU format.

Transmission media
May vary. One widely used option is the RS485 bus physics, a twisted-pair, shielded cable with
terminators.

Diagnostics

Detailed diagnostic messages for rapid trouble-shoot-ing are shown on the CPU display or can be called
using the programming tool.
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Brief information about PROFIBUS DP

PROFIBUS DP (Process Field Bus - Decentral Periphery)

PROFIBUS DP is an open, high-speed and widely-used field bus. It provides multi-master and master-
slave communication in the field area. This field bus can accordingly be used for AC500 and AC31
control system series and for field-bus-neutral FBP devices (decentralized I/Os and intelligent switching
devices) via the PROFIBUS-FBP connector.

Communication

The masters rule data traffic on the bus. When in possession of the bus access authorization (token), the
masters can transmit data without an external request. The passive devices, known as slaves, do not
receive any bus access rights; they acknowledge messages received, or respond to a query from a
master. Baud rates from 9.6 kBaud to 12 MBaud are supported. A maximum of 126 devices can be
operated on the bus.

Data exchange

This is handled predominantly in cyclical mode be-tween master and slave. The requisite communication
functions have been specified by the PROFIBUS DP basic functions in accordance with EN 50170. Each
master has full write and read access to its assigned slaves, but only read access to the slaves assigned
to other bus masters. There is no direct data exchange between masters. Acyclical services (DP-V1) for
parameterization and diagnostics between master and slave are also available. This is performed in
parallel to the master’s cyclical user data traffic.

PROFIBUS DP - the functionality at a glance

* Max. 126 subscribers via amplifier and max. 32 subscribers (master/slaves) per bus segment

* Data transmission rate from max. 12 MBit/s with a cable length of 100 m, up to 93.75 kBit/s with 1200 m

* Multi-master or master/slave communication. Bus access of the masters using token

* Connection of the master CPU and the associated communication module via a 9-pole SUB-D plug
connector. Connection of slaves (CPU, I/Os and intelligent switching devices) via FieldBusPlug

* The system cable is a shielded twisted-pair line or a fiber-optic cable; transmission standard EIA RS485

Diagnostics

Detailed diagnostic messages for rapid trouble-shooting are shown on the CPU display or can be called
using the programming tool. In addition, the device status is indicated at the communica-tion module by
four LEDs.
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Documentation overview

The documentation consists of six parts:

CoDeSys programming system - Describes the functionality of the programming software
Target system - Documentation of the AC500 system

CoDeSys libraries

CoDeSys visualization

CoDeSys HMI

CoDeSys license management

CoDeSys programming system

Section Comment

A brief introduction to CoDeSys - Explanation of the acronym 'CoDeSys'
- Software functionality

- Components of a project

- Programming languages

- Debugging
We write a little program - Controlling a traffic signal unit
- Visualizing a traffic signal unit
The individual components - Main window and functions

- Options for project organization

- Object handling (blocks, data types, visualizations,
resources)

- Editing functions

- Online functions

- Explanation of the help system

Editors in CoDeSys - General

- Declaration editor for the variables

- Pragma instructions for controlling the compilation
process

- Text editor for instruction list and structured text

- Graphical editors for sequential function chart, ladder
diagram, function block diagram and free-graphic
function block diagram editor

The resources - PLC configuration

- Global variables

- Alarm configuration

- Library manager

- Logging (chronological recording of actions during
online session)

- Task configuration

- Watch and recipe manager

- Workspace (image of the project options set)
- Target system settings

- Target specific resources

ENI revision control ENI (engineering interface for accessing an external
project database from the programming system)

IEC operators and additional norm- - Arithmetic operators (ADD, MUL, SUB, ...)

extending functions - Bitstring operators (AND, OR, XOR, NOT)

- Bitshift operators (SHL, SHR, ROL, ROR)

- Selection operators (SEL, MAX, MIN, LIMIT, MUX)

- Comparison operators (GT, LT, LE, GE, EQ, NE)

- Address operators (ADR, ADRINST, BITADR, content
operator)

- Calling operator (CAL)

- Type conversions

- Numeric operators (ABS, SQRT, LN, LOG, ...)

- Initialization operator (INI)
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Section Comment

Operands in CoDeSys - Constants
- Variables
- Addresses
- Functions

Data types in CoDeSys

- Standard data types
- Defined data types

Overview of operators and library blocks

Command line / command file commands

- Commands provided when CoDeSys is started
- Command set for building a command file (Cmdfile)

Use of keyboard

- Operating CoDeSys using the keyboard only
- Key combinations

Siemens import (not available)

Commands for importing blocks and variables from
Siemens STEPS files

DDE communication

Using the DDE interface (Dynamic Data Exchange)

Keywords in CoDeSys

Reserved keywords in CoDeSys (ABS, ACOS, ADD, ...)

CoDeSys files

Files generated by CoDeSys

Compiler errors and warnings

Information about possible error and warning messages
displayed in the message window during project
compilation.

Documentation for the AC500 system

Section

Comment

Introduction

- Overview: Here you can gain an overview of the
AC500 system. This section provides further useful
information.

- First steps when working with AC500 and S500-FBP;
examples

- For AC1131 experts

Your tasks - Documentation from the user's
point of view

- Engineering company

- Sales and export

- Control cabinet building and construction
- Commissioning

- Program creation

- Operation, service and maintenance

- Training and education

- Callcenter, helpline

AC500 hardware

- System data

- CPU terminal bases and terminal units
- CPUs

- Communication modules

- CS31 modules

- FBP interface modules

- Digital input and output modules

- Analog input and output modules

- Accessories

S500-FBP hardware (system description)

- System data and system structure
- Terminal units

- FBP interface modules

- Digital input and output modules

- Analog input and output modules
- Accessories
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Section

Comment

Block libraries

- System libraries

- Modbus library

- Series 90 AC500 library

- ASCII communication library
- CS31 library

- Ethernet library

- PROFIBUS DP library

- CANopen library

- DeviceNet library

- DC541 library

System technology

- Basic units
- Couplers
- 1/0O modules

OPC

OPC (Object Linking and Embedding) for Project
Control - a standardized interface for accessing
process data

CoDeSys libraries

Section Comment
'Standard.lib' library Standard library
‘util.lib library Various blocks, e.g. for BCD conversion, bit/byte

functions, etc.

'‘AnalyzationNew.lib' library

Analysis of expressions

CoDeSys system libraries

Depends on the target system

CoDeSys visualization

Section

Comment

Creating a visualization object

A CoDeSys project block. The project block

contains a set of visualization elements and can
have specific properties as one complete object

Inserting visualization elements

E.g. rectangle, curve, button, etc.

Positioning visualization elements

Selecting, copying, modifying, etc. of visualization
elements

Configuring the visualization, visualization
elements or visualization objects

- Configuring the visualization - Overview

- Configuring selected elements using
configuration dialogs

- Summarizing graphical elements to one
visualization object which can have specific
parameters assigned

Visualization in online mode

With operation by keyboard (configurable)

Visualizations in libraries

Storage of visualizations in libraries

System variables within the visualization

Implicitly created system variables for
programming visualizations

Possible key combinations

For operation by keyboard

G1 Introduction to AC500

AC500 / Issued: 07.2006



CoDeSys HMI

Section

Comment

Overview

Runtime system for execution of visualizations

Installation, starting and operation

- Program which has to be purchased and
installed separately

- Notes regarding start from command line

- Operation by keyboard/mouse via visualization
elements

CoDeSys license management (not available)

Section

Comment

Overview

License management using the tool

Creating a module which is subject to licensing

Using the command 'File -> Save as -> Edit
License Information dialog'
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Short description of the hardware

Example of an AC500 system.

1. Back-lighted LCD display and keypad

2. SD card slot

3. Plug-in communication modules (1 to max. 4)
4. Optionally with integrated Ethernet or ARCNET
5. FBP interface (for slave)

6. Two serial interfaces for programming, ASCII,
Modbus or CS31 field bus (master)

7. Expandable by up to seven local /O modules

Figure: AC500 system, module arrangement beginning from the left: communication module, CPU, I/O
module

CPUs
Available in three performance classes:
* PM571 (64kB memory, 2 RS-232/485 interfaces - programming, MODBUS/CS31 (COM1), 1 x FBP)
* PM581 or PM582 (256kB or 512kB memory, 2 RS-232/485 interfaces - programming, MODBUS/CS31

(COM1), 1 x FBP)
* PM591 (4MB memory, 2 RS-232/485 interfaces - programming, MODBUS/CS31 (COM1), 1 x FBP)

All three types are also available with an integrated Ethernet coupler (TCP/IP).

Communication modules
For connection to standard field bus systems and integration into existing networks.
Ethernet coupler supporting the protocols TCP/IP, UDP/IP and Modbus TCP.
Coupler for fieldbus systems — PROFIBUS DP, DeviceNet and CANopen.

Up to four communication modules in any desired combination are allowed at one CPU.

The CPU terminal base

For easy plug-in mounting of a CPU and one, two or four communication modules (three types available
accordingly).

The 1/0 modules

Digital and analog in different versions. Can be simply plugged onto the terminal units — for local
expansion of the CPU (max. seven modules) and decentralized expansion via the FBP interface (max.
seven modules, thereof max. four analog modules). Flexible use thanks to configurable channels.

The I/O terminal units

Multi-purpose usage for both digital and analog I/Os, for 1, 2 and 3-wire designs. Enable simple
prewiring without electronics. For 24 V DC and 230 V AC, optionally for spring or screw-type terminals.

The FBP interface module
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With embedded digital I/Os and a field-bus-neutral interface for connecting the chosen FBP connector.
For decentralized expansion by up to seven I/O modules.

The SD card

The SD memory card is used for the following purposes: Backup of user data, storage of the user
program, storage of the project’s source code, update of the internal CPU firmware.

Short description of the software

[

=l b

e

—

=

Programming in conformity with IEC 61131-3

AC500 Control Builder provides the following functionalities:

m Five standardized programming languages: Function Block Diagram (FBD), Instruction List (IL),
Ladder Diagram (LD), Structured Text (ST), Sequential Function Chart (SFC)

m Free graphical function chart (CFC)
m Debugging functions for the program test: Single step, Single cycle, Breakpoint
Offline simulation

IEC 61131-3 commands can be simulated without a PLC being connected, including the relevant
malfunctions. After the program test, the application can be downloaded to the control system.

Sampling trace
Timing diagrams for process variables and storage of data in a ring buffer with event trigger.
Recipe management and watch lists

Values of selected variables are displayed. Pre-defined values can be assigned to variables which can
then be downloaded to the control system all at once (“Write recipe”). Ongoing values from the control
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system can also be pre-assigned for reading into the Watch and Recipe Manager, and stored in memory
there (“Read recipe). These functions are also helpful, for example, for setting and entering control
parameters.

Visualization

Includes color change, moving elements, bitmaps, text display, allows input of setpoint values and
display of process variables read from the PLC, dynamic bar diagrams, alarm and event management,
function keys and ActiveX elements.

Configurators of the communication interfaces
Integrated field bus configurator SYCON.net for PROFIBUS DP, CANopen, DeviceNet, Ethernet,
Modbus and CS31.

Open interfaces

DDE and OPC.

Programming

Serial or via Ethernet or ARCNET networks.

Engineering interface

Provides access from the programming system to an external project database in which the program
source code of one or several automation projects is managed. Optionally, a version control system,
such as Visual Source Safe, can be used in order to ensure data consistency of the program code for
several different users and projects.

e Comprehensive libraries.
* Windows 32-bit standard.
* Operating systems Windows 2000 and XP.
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Operating and displaying

The AC500 offers as well an extensive range of products for communication between operator and
machine. There are many different displays to choose from, which satisfy application-specific demands
regarding required operator actions and information density.

Users can communicate with the AC500s CPUs via the various operator panels, read and write access
on device data is possible. Configuration is quick and easy to perform, using the same software for all
devices (programming software CPsoft, 1SBS 260 283 R1001). Commands and programming
languages are identical for all devices. With regard to frequently harsh conditions at the place of
installation, all operator panels fulfill IP65 protection at the front. Operator panels and automation
devices are linked either simply via serial interfaces, or in case of complex applications via Ethernet,
Modbus or PROFIBUS DP.
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Overview of CP500 operator panels - part 1

Lb b bdd ddd

Type CP501 CP502 CP503 CP511 CP512
Order Number 1SBP 260 170 1SBP 260 171 1SBP 260 172 1SBP 260 173 1SBP 260 174
R0101 R0101 R0101 R0101 R0101
Display type STN LCD STN LCD STN LCD STN LCD B/W STN LCD
with backlight with backlight with backlight with backlight with backlight
Representation Text Text Text Grafic and text Grafic and text
Display size 2 lines x 16 2 lines x 20 4 lines x 20 240 x 64 pixels 240 x 128
characters characters characters (5.2") pixels (5.3")
Display area 55,7 x11,0 73,5x11,5 70,4 x 20,8 127,2 x 33,9 120,0 x 64,0
W x H (mm)
Text height 5 5 5 variable variable
(mm)
LEDs 5 (2 colors) 16 (2 colors) 16 (2 colors)
Function keys 4 3 5 8 16 (8 with
labeling strip)
Web functions X X
Buzzer X X
Alarm 1 group 4 groups 4 groups
management
Time channel X X X X
Real-time X X X X
clock
Trend curves real-time developing of
values
Data logger
Recipe X X X X
management
Report printing X X X X
Password 8 levels 8 levels 8 levels 8 levels
protection
Multilanguage X X X X
support
Application 16 kB Flash 64 kB Flash 64 kB Flash 400 kB Flash 400 kB Flash
memory
Power supply 24V DC 24V DC 24V DC 24V DC 24V DC
Current 200 mA 150 mA 150 mA 450 mA 450 mA
consumption
Ambient 0-50°C 0-50°C 0-50°C 0-50°C 0-50°C
temperature
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Type CP501 CP502 CP503 CP511 CP512
Communication RS232 or RS232, RS422 RS232, RS422 | RS232, RS422 | RS232, RS422
interfaces RS422 RS485 (of which 2
at the same time)
Expansion - - - 1 1
slots
Degree of IP65 IP65 IP65 IP65 IP65
protection
front cover
Dimensions 104 x 69 x 38 142 x 100 x 29 147 x 163,5 x 211 x 198 x 69 214 x 232 x 87
WxHxD 38
(mm)
Weight (kg) 0.2 0.5 0.7 15 14
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Overview of CP500 operator panels - part 2

LT LR T T T

TAEETENT - | I
Type CP513 CP551 CP552 CP554 CP555
Order Number 1SBP 260 175 1SBP 260 176 1SBP 260 177 1SBP 260 178 1SBP 260 179
R0101 R0101 R0101 R0101 R0101
Display type TFT 256 Color Touch B/W 16 grey levels TFT 256 Color TFT 256 Color
LCD with STN Touch LCD touch LCD touch LCD
backlight with backlight with backlight
Representation | Grafic and text Grafic and text Grafic and text Grafic and text Grafic and text
Display size 320 x 240 Pixel 320 x 240 Pixel 320 x 240 Pixel 320 x 240 Pixel 640 x 480 Pixel
Display area 115,2 x 86,4 78,0 x 58,5 115,2 x 86,4 115,2 x 86,4 211,2 x 158,4
W x H (mm)
Text height variable variable variable variable variable
(mm)
LEDs 16 (2 colors)
Function keys 16 (8 with
labeling strip)
Web functions X X X X X
Buzzer X X X X X
Alarm 16 groups 4 groups 5 groups 5 groups 11 groups
management
Time channel X X X X X
Real-time clock X X X X X
Trend curves developing of developing of developing of developing of developing of
values values values values values
Datalogger X X X X X
Recipe X X X X X
management
Report printing X X X X X
Password 8 levels 8 levels 8 levels 8 levels 8 levels
protection
Multilanguage X X X X X
support
Application 400 kB Flash 400 kB Flash 400 kB Flash 400 kB Flash 1600 kB Flash
memory
Power supply 24V DC 24V DC 24V DC 24V DC 24V DC
Current 550 mA 450 mA 400 mA 450 mA 1A
consumption
Ambient 0-50°C 0-50°C 0-50°C 0-50°C 0-50°C
temperature
Communication RS232, RS422 RS232, RS422 RS232, RS422 RS232, RS422 RS232, RS422
interfaces RS485, RS485 RS485
Ethernet (of which 2 at (of which 2 at

(of which 2 at
the same time)

the same time)

the same time)

Expansion slots 2 - 1 1 2
Degree of IP65 IP65 IP65 IP65 IP65
protection

front cover

Dimensions 276 x 198 x 89 138 x 100 x 30 200 x 150 x 69 200 x 150 x 69 290 x 250 x
W x H x D (mm) 105
Weight (kg) 1.7 1.4 1.5 1.5 3.3
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Services

Service - Control Engineering

ABB operates a Technical Support Center to assist with even the most difficult of problems.

e Consultation by phone (Helpline)
e Failure analysis and removal at the machine/installation

In order to provide the customer with qualified assistance, customers are requested to provide the
following:

e Provide all required application documentation and information.
e Provide access (if required) to the system being examined.
e Assign key individuals to assist as required.

For inquiries and orders, please contact:

ABB STOTZ-KONTAKT GmbH

Dept. STO/CPT, Control Engineering Helpline
Eppelheimer Straf3e 82

D-69123 Heidelberg

Postfach 10 16 80
D-69006 Heidelberg

Phone +49 6221 701-1444
Telefax +49 6221 701-1382

E-mail: desst-helpline.desto@de.abb.com

For further information about control engineering please also refer to our Internet Website
http://www.abb.de/stotzkontakt.

Repair services and replacement devices
The following services are also covered by our activities:

o Delivery of replacement devices
¢ Repair of defective devices and systems

Please contact your responsible sales office for your inquiry.
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Seminars/Workshops

We also offer seminars and workshops to support you in planning, commissioning and operation of
Advant Controller AC500 controls. Please contact:

ABB STOTZ-KONTAKT GmbH

Dept. STO/VPS

Eppelheimer StraBe 82 Postfach 10 16 80

D-69123 Heidelberg D-69006 Heidelberg

Phone +49 6221 701-1202 or -1205

Telefax +49 6221 701-1361

E-mail: Dieter.Druschke @de.abb.com or Heinrich.Happle @de.abb.com

If desired, we also offer seminars at the customer's facility. Please find detailed information in our
seminar brochure. You can order this brochure from the address given above or from every ABB
STOTZ-KONTAKT GmbH office or you can download it from our Internet website (PDF file, see the
following link).

Please send your enrolment directly to ABB STOTZ-KONTAKT GmbH using the address given above or
via Internet (http://www.abb.de/stotzkontakt -> Schulungen und Seminare -> Seminare).

If necessary, it is also possible to arrange the seminar contents according to the customer's wishes.
Depending on the special requirements, the training can be held in Heidelberg or at any other location
favored by the customer. We are pleased to prepare an individual offer for you according to your special
requirements.
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Addresses

ABB STOTZ-KONTAKT GmbH
P.O. Box 10 16 80

D-69006 Heidelberg
Telephone: ++49 62 21/ 701-0
Telefax: ++49 62 21 /701-729

http://www.abb.de/stotz-kontakt

ABB Entrelec - Control Division
184, rue Léon Blum

F-69100 Villeurbanne / France
Telephone: ++33 (0) 4 72 35 35
Telefax: ++33 (0) 4 72 35 12

http://www.abb.com/lowvoltage
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Regulations concerning the appropriate and safe setup of systems and
installations

Apart from the basic ,Regulations for the Setting up of Power Installations DIN VDE* 0100 and for ,The
Rating of Creepage Distances and Clearances” DIN VDE 0110 Part 1 and Part 2 the regulations ,The
Equipment of Power Installations with Electrical Components“ DIN VDE 0160 in conjunction with DIN
VDE 0660 Part 500 have to be taken into due consideration.

To insure project success and to insure that all systems are properly and safely installed, the customer
must be familiar and proficient with the following standards and must comply with their directives:

¢ Working & Process Machinery: DIN VDE 0113 Part 1 & Part 200
e Close proximity to dangerous voltages: DIN VDE 0106 Part 100
e Protection against direct contact: DIN VDE 0160, DIN VDE 0110 Part 1

The user has to guarantee that the devices and the components belonging to them are mounted
following these regulations. For operating the machines and installations, other national and international
relevant regulations, concerning prevention of accidents and using technical working means, also have
to be met.

Advant Controller Devices are designed according to: IEC 1131 Part 2 under overvoltage category Il per
DIN VDE 0110 Part 2.

For direct connection of AC Category Il overvoltages provide protection measures for overvoltage
category Il according to IEC-Report 664/1980 and DIN VDE 0110 Part 1.

Equivalent standards:

DIN VDE 0110 Part 1 «— IEC 664

DIN VDE 0113 Part 1 & EN 60204 Part 1

DIN VDE 0660 Part 500 <« EN 60439-1 « IEC 439-1
All rights reserved to change design, size, weight, etc.

* VDE stands for ,Association of German Electrical Engineers*.
Safety technical instructions

Please read!

General

Completely safe installation and starting up and problemfree functioning of the devices at their work
location can be ensured by observing the following instructions.

Qualified personnel

Both the control system AC500 and other components in the vicinity are operated with dangerous
contact voltages. Touching parts, which are under such voltages, can cause grave damage to health.

In order to avoid such risks and the occurrence of material damage, everyone involved with the
assembly, starting up and servicing must possess pertinent knowledge of the following:

o the automation technology sector,

e dealing with dangerous voltages,

e using standards and regulations, in particular VDE, accident prevention regulations and regulations
concerning special ambient conditions (e.g. areas potentially endangered by explosive materials,
heavy pollution or corrosive influences).
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Use as directed

Properly installed systems that are "used as directed" and properly conform with the applicable codes,
regulations and sound engineering principles pose no risks or dangers to health.

"Used as directed" implies that the devices are installed, maintained and operated in accordance with
appropriate ABB manuals & documents.

No liability is assumed for the direct or indirect consequences of the improper use, improper application
or inadequate maintenance of these devices.

Risk reduction instructions

A Protect the devices from dampness, dirt and damage during transport, storage
and operation!

& Do not operate devices outside of the specified, technical data!

Trouble-free functioning cannot be guaranteed outside of the specified data.

A Operate the control system only in an enclosed housing (switch cabinet)!

Due to their construction (degree of protection IP 20 according to EN 60529) and their connection
technology, the devices are suitable only for operation in enclosed housings (switch cabinets).

& Earth the devices!

The earthing (switch cabinet earthing, PE) is supplied both by the mains connection (or 24 V supply
voltage) and via DIN rail.

The DIN rail must be connected to the earth before the device is subjected to any power. The earthing
may be removed only if it is certain that no more power is being supplied to the control system.

In the description for the devices (operating manual or AC500 system description), reference is made at
several points to earthing, electrical isolation and EMC measures. One of the EMC measures consists of
discharging interference voltages into the earthing via Y-type capacitors. Capacitor discharge currents
must basically be able to flow off to the earthing (in this respect, see also VBG 4 and the relevant VDE
regulations).

In the description, special attention must be paid to designs using electrical isolation, earthing and EMC
measures for the reasons stated. For more information see Target System -> AC500/S500-FBP ->
Hardware AC500 -> System data -> General considerations for EMC-conforming assembly and
construction.

The earthing concept of these busses apply to the connection to external bus systems.

A Connection of the supply voltage

The supply voltage (or mains connection) terminal block must only be plugged in or withdrawn with the
power offl

The same applies to the terminal blocks of input or output channels (e.g. relay outputs) if they are
operated with dangerous contact voltages.

A Do not open live devices!

The devices work with voltages with which contact must be avoided under all circumstances. Therefore
they must not be opened when live. The same applies to the networking interfaces.

Lifting up the cover of the battery compartment to exchange the battery module is not construed as
opening in this context.
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A Do not obstruct the ventilation for cooling!

The ventilation slots on the upper and lower side of the devices must not be covered by wiring, cable
ducts and things like that.

A Run signal and power wiring separately!

Signal and supply lines (power cables) must be laid out so that no malfunctions due to capacitive and
inductive interference can occur (EMC).

A Precautions against wiring short-circuits and breakages
Connection plans and user software must be created so that all technical safety aspects, legal

regulations and standards are observed. In practice, possible shortcircuits and breakages must not be
able to lead to dangerous situations. The extent of resulting errors must be kept to a minimum.

& Use only ABB approved lithium battery modules!

At the end of the battery’s lifetime, always replace it only with a genuine battery module.

& Never short-circuit or operate lithium batteries with the polarities reversed!
They are likely to overheat and explode. Avoid chance short circuiting and therefore do not store

batteries in metal containers and do not place them on metallic surfaces. Escaping lithium is a health
hazard.

& Never charge lithium batteries!

Lithium batteries are primary cells and cannot be recharged. Attempts to charge lithium batteries lead to
overheating and possible explosions.

A Dispose of lithium batteries environmentally consciously!
Do not open lithium batteries and never throw them into fires (risk of explosion). Do not dispose of along

with the household rubbish but in an environmentally conscious manner, in accordance to local-authority
regulations.

Additional notes

& Avoidance of electrostatic charging
ATTENTION

Electrostatic charging can cause internal defects of the devices and impair the
proper function. Observe the following rules when handling the system:
e Touch an earthed object in order to discharge the electrostatic
charging.
e Wear a suitable earthed strap around your wrist.

e Do not touch any connections or pins on the printed circuit boards.
¢ Do not touch any circuits inside the devices.

e [f available, use a work place which is equipped with suitable
electrostatic discharge.

e In order to avoid electrostatic charging, the devices must only be
stored when packed in suitable packaging material.

Minimum clearances: Refer to target system - AC500/S500-FBP -> Introduction -> Getting Started ->
Getting Started with AC500 -> Assembling the system

ABB STOTZ-KONTAKT GmbH Heidelberg
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Getting started with AC500

Important User Information

Solid state equipment has operational characteristics differing from those of electromechanical
equipment. Because of this difference, and also because of the wide variety of uses for solid state
equipment, all persons responsible for applying this equipment must satisfy themselves that each
intended application of this equipment is acceptable.

In no event will ABB be responsible or liable for indirect or consequential damages resulting from the use
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the
many variants and requirements associated with any particular installation, ABB cannot assume
responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by ABB with respect to use of information, circuits, equipment, or software
described in this manual.

Throughout this manual we use notes to make you aware of safety considerations.

Identifies information about practices or circumstances that can cause an
explosion in a hazardous environment, which may lead to personal injury or
death, property damage, or economic loss.

Identifies information that is critical for successful application and
understanding of the product.

Identifies information about practices or circumstances that can lead to
personal injury or death, property damage, or economic loss. Attentions help
you:

e identify a hazard

e avoid a hazard

e recognize the consequence

SHOCK HAZARD Labels may be located on or inside the device to alert people that dangerous
voltage may be present.

SHOCK HAZARD Labels may be located on or inside the device to alert people that surfaces may
have dangerous temperatures.

& WARNING

A IMPORTANT

& ATTENTION

Environment and Enclosure Information

A Environment and Enclosure

ATTENTION

This equipment is intended for use in a Pollution Degree 2 industrial
environment, in overvoltage Category Il applications (as defined in IEC
publication 60664-1), at altitudes up to 2000 meters without derating.

This equipment is considered Group 1, Class A industrial equipment according
to IEC/CISPR Publication 11. Without appropriate precautions, there may be
potential difficulties ensuring electromagnetic compatibility in other
environments due to conducted as well as radiated disturbance.

This equipment is supplied as "open type" equipment. It must be mounted
within an enclosure that is suitably designed for those specific environmental
conditions that will be present and appropriately designed to prevent personal
injury resulting from accessibility to live parts. The interior of the enclosure must
be accessible only by the use of a tool. Subsequent sections of this publication
may contain additional information regarding specific enclosure type ratings
that are required to comply with certain product safety certifications.

See NEMA Standards publication 250 and IEC publication 60529, as
applicable, for explanations of the degrees of protection provided by different
types of enclosure. Also, see the appropriate sections in this publication, as

G1 Introduction to AC500 1-32 AC500 / Issued: 07.2006



well as the S500 User's manual for additional installation requirements
pertaining to this equipment.

Before starting

Use this document as a guide for installing and powering-up your AC500 PLC. You should already be
familiar with the system components.

How to handle AC500 components

A ATTENTION

Preventing Electrostatic Discharge

This equipment is sensitive to electrostatic discharge, which can cause internal
damage and affect normal operation. Follow these guidelines when you handle
this equipment:

e Touch a grounded object to discharge potential static.
Wear an approved grounding wrist strap.
Do not touch connectors or pins on component boards.
Do not touch circuit components inside the equipment.
If available, use a static-safe workstation.
When not in use, store the equipment in appropriate static-safe
packaging.

Make sure that you have all the components you need

To use the AC500 PLC (in our example CPU PM581-ETH) you should use at least the following parts:

Part Number

Designation

1SAP 1121 00 R0170

TB521-ETH Terminal Base for CPU with 2 coupler slots

1SAP 1401 00 R0O170

PM581-ETH CPU

1SAP 1806 00 RO001

TA524 Dummy coupler module to cover the unused coupler slots

1SAP 1802 00 R00O01

TK501 Programming Cable D-Sub / D-Sub

Optional:

Part Number

Designation

1SAP 1803 00 R0O001

TA521 Lithium Battery

1SAP 1801 00 RO0O1

MC502 Memory SD-Card
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You can use the following components to add additional I/O modules:

If you want ... ... use the following component(s):
e to connect a digital 24 VDC sensor or DI524 (32 DI ), DC522 (16DC), DC523 (24DC),
actuator to the CPU ... DC532 (16DI/16DC) or DX522 (8DI/8 DO-R) with

the corresponding terminal unit with screw or
spring connection TU515/516 or TU531/532
e to connect a 115-230 VAC sensor or DX531 (8Dl 115-230 V AC / 4 DO-R) +

actuator to the CPU ... corresponding Terminal Unit TU531/532 with
screw or spring technology

e to connect an analog 24 VDC sensor or Al523 (16AI U/I/PT100), AO523 (16A0), AX521

actuator to the CPU ... (4Al/4A0 U/I/PT100) or AX522 (8AI/8A0
U/I/PT100) + corresponding Terminal Unit
TU515/516
e to label the I/O channels ... TA523 (Pluggable Marking Holder) + TA525 Set

of Plastic Markers

The following components are recommended for fieldbus communication:

If you want ... ... use the following component(s):
e the system to act as a master on
. CM572-DP for PROFIBUS DP, CM575-DN for
F.)ROFIBUS DP, DeviceNet or CANopen DeviceNet or CM578-CN for CANopen
fieldbuses ...

e the system to act as a slave on FieldBusPlug standard plugs like PDP22-FBP
PROFIBUS DP, DeviceNet or CANopen (PROFIBUS DP slave) or DNP21-FBP
fieldbuses ... (DeviceNet) or other one’s

e to exchange data via the network ... CM577-ETH to achieve Ethernet TCP/IP

communication with integrated 2-ports switch

System planning
Consider the following when planning your AC500 system:

e The AC500 PLC consists of a CPU Terminal Base TB5xx (from 1 to 4 coupler slots) and a pluggable
CPU. Three different CPU classes are offered: from PM571 with 64kB memory up to PM591 with
4MB memory; available also with integrated Ethernet coupler.

e Proper CPU Terminal Base selection requires that sufficient slots are available for all current or
future network and fieldbus communication modules (e.g. Ethernet, ARCNET, PROFIBUS, etc.) if
required.

e Up to 4 communication couplers can be connected to the CPU through the dedicated CPU terminal
base.

e All types of external communication couplers can be used together in the same time but only up to 4
external couplers in total (e.g. a mix of coupler types like Ethernet + Ethernet + Profibus DP +
CANopen, efc ...).

e The total number of communication couplers (internal + external) is limited to 5.

e The CPU terminal base is always the left-most device in the system.

e An external 24 Vdc power supply has to be provided to the CPU Cluster; the additional I/O modules
have to be installed to the right of the PLC module.

e The AC500 PLC module supports as many as 7 local /0O expansion modules.

e An additional process power supply has to be provided for the I/Os of each module. Each I/O
expansion module can be powered with its own power supply (for isolation purposes) or the same
power supply can also be used.

e One FieldBusPlug can be plugged directly into an AC500 PLC cluster
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Steps for installation

2

Installation step: Further
information:

1 Snap the AC500 PLC Terminal Base onto DIN Rail or wall-mount with
screws.

2 Snap the additional Terminal Units for I/O modules onto DIN Rail
(optional) or screw them (wall mounting).

3 Make the sensor/actuator wire connections according to the dedicated M
Electronic module you want to use. Provide external process power
supply as required.

4 If required, make the fieldbus connections according to the dedicated W)
master coupler module you want to use.

5 Plug the appropriate electronic and I/O modules in the correct locations
(CPU module, communication couplers on TB, and eventually also I/O
modules onto dedicated TUs).

6 Install the battery and the memory SD card; this is optional and the
CPU is able to run without them.

If required, make the FBP fieldbus slave connection according to the ™)
chosen FBP and use the dedicated FBP accessories (cables, master
cable to M12, line termination, power supply connector, etc...).

8 If required, plug the FBP-Plug on the M12 connector located on the
CPU Terminal Base of the AC500 PLC.

9 Connect a programming cable (e.g. TK501 in COM2/PLC and
COM1/PC; TK502 is necessary for COM1/PLC) on the PC and on the
AC500 PLC.

10 | Setthe power on (process power supply first and PLC power supply).

11 If required, set the an address for the integrated Ethernet
communication interface by using the front face LCD Display +
keyboard of the CPU module (see the dedicated chapter of the user’s
manual).

12 | Install the AC500 Control Builder programming software on your PC. If ™
required, also copy the appropriate EDS/GSD files into the Fieldbus
configurator (AC500 Control Builder) to manage the possible fieldbus
slave modules connected to the AC500 master couplers.

13 | Program the hardware configuration.

OO o0 O O OO0 000

(*) Refer to the AC500 hardware description for proper wiring and addressing information.

(**) Refer to the Installation Instructions for the particular FBP devices. Follow appropriate fieldbus
practices outline by the conventions and standards of each protocol used in the system.
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Assembling the system

The AC500 modules are not designed for removal or insertion under power.
Because of unforeseeable consequences, it is not allowed to plug or unplug
modules with the power being ON.

& WARNING

Disconnecting the FBP or any powered modules while energized in a
hazardous location could result in an arc, which could create a flammable
ignition resulting in a fire or explosion.

Be sure that power is removed and that an area has been thoroughly checked
to insure that flammable materials are not present prior to proceeding.

Using S500 I/O Modules

The S500 I/O modules could be used either directly connected to an AC500 CPU (central expansion) or
together with an FBP Interface Module DC505-FBP + an FBP (PROFIBUS DP, DeviceNet, etc.) as
decentralized expansion.
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Figure: S500 1/0 modules directly connected to an AC500 CPU (central /O expansion)
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Figure: S500 I/0O modules connected to an FBP Interface Module DC505-FBP with an FBP

(decentralized expansion)
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Minimum spacing
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Figure: AC500/S500 module mounting into cabinets

Maintain spacing from enclosure walls, wireways, adjacent equipment, etc. Allow minimum 20 mm (1 in.)
of space on all sides, as shown. This provides ventilation and electrical isolation.
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A Important: Horizontal mounting is highly recommended. Vertical mounting is possible,
however, derating consideration should be made to avoid problems with poor air circulation and the
potential for excessive temperatures (see also the AC500 system data, operating and ambient
conditions, for reduction of ambient temperature).

E.U[[B Note: By vertical mounting, always place an end-stop terminal block (e.g. type BADL, P/N:
1SNA399903R0200) at the bottom and on the top of the modules to properly secure the modules.

By high vibration applications and horizontal mounting, we also recommend to place end-stop

terminals at the right and left side of the device to properly secure the modules, e.g. type BADL,
P/N: 1SNA399903R0200.

Insertion / replacement of the Lithium battery

The CPU is shipped without a battery. Please order the TA521 lithium battery separately. The battery is
used to retain data stored in the user's RAM and in the Real Time Clock. Although the CPU can be used
without any battery, it is recommended to install it to avoid process data loss.

The CPU monitors the battery status. A low battery error is output before the battery condition becomes

critical (about 2 weeks before). After the error message appears, the battery should be replaced as soon
as possible.

A The TA521 Lithium Battery is the only one, which can be used with AC500 CPUs.
ATTENTION

The following procedures describe the insertion / replacement of the Lithium battery.

i i + )

WARNING! WARNING!

Use of Use of :I
incorrect incorrect p—
battery may battery may -
cause fire or cause fire or 2

explosion. explosion.

la 1b

£ £
| WARNING!
Use of
L incorrect
- battery may
4+5 cause fire or
explosion.

6

+
0
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Figure: Insertion / replacement of the Lithium battery
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Insertion of the battery:
1. Open the battery compartment by inserting a fingernail in the small locking mechanism, press it
down and slip down the door. The door is attached to the front face of the CPU and cannot be
removed!

2. Remove the TA521 battery from its package and hold it by the small cable.

3. Insert the battery connector into the small connector port. The connector is keyed to find the correct
polarity (red = plus pole = above).

4. Bend the cable and insert first the cable and then the battery into the compartment, push it until it
reaches the bottom of the compartment.

5. Arrange the cable in order not to inhibit the door to close.

6. Pull-up the door and press until the locking mechanism snaps.

A In order to prevent data losses or problems, the battery should be replaced after 3
NOTICE years of utilisation or at least as soon as possible after receiving the “Low battery
Warning” indication.

Don’t use a battery older than 3 years for replacement. Do not keep batteries too
long in stock.

Replacement of the battery:

In order to avoid any data losses (if needed), the battery replacement should be
done with the system under power. Without battery and power supply there is no
data buffering possible.

A ATTENTION

1. Open the battery compartment by inserting a fingernail in the small locking mechanism, press it down
and slip down the door. The door is attached to the front face of the CPU and cannot be removed.

2. Remove the old TA521 battery from the battery compartment by pulling it by the small cable. Remove
then the small connector from the socket, do this best by lifting it out with a screwdriver (see photo).

3. Follow the previous instructions to insert a new battery.

Lithium batteries must not be re-charged, not be disassembled and not be
disposed of in fire. They must be stored in a dry place. Exhausted batteries
must be recycled to respect the environment.

A ATTENTION

Please refer to chapter "Hardware/Accessories/TA521" for the technical data sheet of the Lithium battery
TA521.
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Insertion of the

AC500 CPUs are
Memory Card is u

SD memory card

supplied without an SD Memory Card. It therefore must be ordered separately. The SD
sed to back-up user data and store user programs or project source codes as well as

to update the internal CPU firmware. AC500 CPUs can be operated with and without SD Memory Cards.

The CPU uses a standard file system, which allows the MC502 SD Memory card to be read with a

standard memory

card reader.

A ATTENTION

The use of memory cards other than the MC502 SD Memory Card is prohibited.
ABB is not responsible nor liable for consequences resulting from use of
unapproved memory cards.

& ATTENTION

In operation, the plugged-in SD Memory Card withstands vibrations up to 1 g.
Without using an SD Memory Card, the CPU itself withstands vibrations up to
4q.

a _ _ _ _ _ - H» | ETH
SYS [«B ITNTNTNTNC Wy | FBP
BATT | «B LT B» | comt SD Memory Card
I/O-Bus | <} B> | com2 MC502
PWR RUN ERR ] —
N\ 8 a [ | E
]
=0 629 =
WARNING! @ ]
(-
_Use of =
incorrect —
= © @
cause fire or MC |-
explosion. @ LPESH
CPU
24V DC 10W

Figure: Insertion of the SD Memory Card

To insert the SD Memory Card, follow the procedure shown below.

1. Remove the SD Memory Card from its package.

2. Insertthem

emory card into the opening of the front face of the CPU with the memory card aligned

as shown above (contacts are visible on the left side, bevelled edge below).

3. Pushonthe

card until it moves forward, then release your pressure, the SD card comes slightly

backward and it locks into the SD card slot.

Removing the SD Memory Card

To remove the card, first push on the card until it moves forward (that unlocks the card), then release
your pressure, the card will go forward out of the slot and can be easily removed.

The technical data sheet for the SD Memory Card can be found in the chapter "Hardware / Accessories /

SD Memory Card

MC502".
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Mounting the System

A During panel or DIN rail mounting of all devices, be sure that all debris (metal
ATTENTION chips, wire strands, etc.) is kept from falling into the controller. Debris that falls
into the controller could cause damage while the controller is energized.

Mounting and Demounting of the Terminal Base, the Terminal Unit and the Electronic
Modules
Mounting on DIN rail

Step 1: Install the 7.5 mm or 15 mm DIN Rail
Step 2: Snap the AC500 Terminal Base (TB5xx)

"

Figure: Mounting of the AC500 Terminal Base (TB5xx)

-l-l-l.l-l-l-l-l.l-l-l-l-l-

The AC500 Terminal Base will be placed on top of the DIN Rail and then snapped on the bottom. Follow
the reverse order to disassembly.

AN

Figure: Disassembly of the CPU Terminal Base (TB5xx) or Terminal Unit (TU5xx)
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Step 3: Mounting of the I/O Terminal Unit (TU515, TU516, TU531 or TU532) to the CPU Terminal Base
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TU516, TU531 or TU532)

Figure: 1/0 Terminal Unit assembly (TU515,

The I/O Terminal Unit is snapped into the DIN rail in the same way as the Terminal Base. Once secured

slide the 1/O unit to the left until it fully locks into place creating a solid mechanical and

to the DIN rail,
electrical connection.

Up to 7 I/0O Terminal Units could be combined with a CPU Terminal Base.

When attaching the CPU Terminal Base and I/O modules, make sure the bus
connectors are securely locked together to ensure proper electrical connection.
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Figure: Maximum configuration (1 CPU Terminal Base plus 7 I/O Terminal Units)
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Disassembly of a Terminal Unit
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Figure: CPU Terminal Base (TB5xx) or I/O Terminal Unit disassembly (TUxx)
A screwdriver is inserted in the indicated place to separate the Terminal Units.

Step 4: CPU or Electronic Module assembly

-

-
—

[OIOI0[QI0IOIO

Figure: Mounting of the CPU (PM5xx) on a Terminal Base (TB5xx), in the same way as I/O modules on
Terminal Units

The CPU or I/O module will be plugged on the dedicated Terminal Base / Terminal Unit. And will be
locked in place. The disassembly is done in reverse order.
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Figure: CPU / 1/0 Module disassembly
For disassembly, press top and bottom, then pull out the CPU / 1/0 module.

Step 5: Communication Couplers on Terminal Base assembly

4

<

Figure: Mounting of a communication coupler (CM5xx) on a CPU Terminal Base (TB5xx)

First insert the bottom nose of the communication Coupler module into the dedicated holes of the
Terminal Base and then rotate the coupler until it will be plugged on the dedicated Terminal Base slot,

push to be sure that the connection is well done. It will be locked in place.

The disassembly is done in reverse order.
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Figure: Communication coupler module disassembly

Disassembly: Press Top and Bottom, then rotate the coupler module and pull it out.
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Panel mounting

If the CPU Terminal Base should be mounted with screws, Wall Mounting Accessories TA526 must be
inserted at the rear side first. These plastic parts prevent bending of the Terminal Base while screwing
on. TB511 needs one TA526, TB521 and TB541 need two TA526.

Rear view

I i
e
M

(@]

a_J P
R

Holes for wall mounting

Rear view

o
TR

2 Front view 3

Figure: Fastening with screws of the Terminal Base TB521-ETH (as an example)

1 The two Wall Mounting Accessories TA526 are snapped on the rear side of the CPU Terminal Base
like DIN rails. The arrows point to the middle of the CPU Terminal Base. One TA526 is turned by 180°.

2 Two accessories for wall mounting inserted

3 CPU Terminal Base, fastened with screws. Use two screws per module (three for the TB). Use M4 or
#8 pan head screws. Mounting screws are required on every module.

By wall mounting, the CPU Terminal Base is earthed through the screws. It is necessary that

o the screws have a conductive surface (e.g. steel zinc-plated or brass nickel-plated)
e the mounting plate is earthed
e the screws have a good electrical contact to the mounting plate
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The following procedure allows you to use the assembled modules as a template for drilling holes in the
panel. Due to module mounting hole tolerance, it is important to follow these procedures:

1.
2.

7.

On a clean work surface, assemble no more than three modules (e.g. one TB + two TUs).

Using the assembled modules as a template, carefully mark the center of all module-mounting
holes on the panel.

Return the assembled modules to the clean work surface, including any previously mounted
modules.

Drill and tap the mounting holes for the recommended M4 or #8 screw.
Place the modules back on the panel and check for proper hole alignment.
Attach the modules to the panel using the mounting screws.

TIP: If mounting more modules, mount only the last one of this group and put the others aside. This
reduces remounting time during drilling and tapping of the next group.

Repeat steps 1 to 6 for any remaining modules.

Grounding considerations

This product is designed to be mounted to a well-grounded mounting surface such as a metal panel.
Additional grounding connections from the AC500 mounting tabs or DIN rail (if used), are not required
unless the mounting surface cannot be grounded. Refer to appropriate Chapter of the S500-FBP User's
Manual, for additional information.

This product is grounded through the DIN rail to chassis ground. Use zinc

A ATTENTION plated yellow-chromate steel DIN rail to assure proper grounding. The use of

other DIN rail materials (e.g. aluminium, plastic, etc.) that can corrode, oxidize,
or are poor conductors, can result in improper or intermittent grounding.

AC500 System dimensions
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Figure: Dimensions of the CPU Terminal Bases (front view)
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View on the left side
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View on the right side

Note: All dimensions are in mm (in.). Hole spacing tolerance: £0.4 mm (0.016 in.)
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Setting of the Slave Address of the FBP plug onto the AC500 CPU (if needed, but
not recommended)

Normally the FBP slave address is set using the AC500 Control Builder. Neverthless it is possible to set
this address using the CPU.

The FieldBusPlug must have a properly assigned slave module address. The AC500 CPU gives them an
address at system power-up. The address can be set with the use of the display and the pushbutton on
the top of the module.

& Attention: The local setting of an FBP address by means of pushbuttons and display has a
higher priority than an FBP address configured by the AC500 Control Builder!

The locally set address replaces the address configured by the software.

It is highly recommended to be extremely careful when modifying the address locally, because it has
high influence on the behaviour of the application.

Up to 99 addresses can be then set with the display.

|
ADD PM581
a _ _ _ ___ I»|ETH
sys|«n QIS0 By | FBP
BATT | <8 LWL B | coMi
I/O-Bus |41 1| cCom2

By uls(ing the (?'::hG,(t)hI? ar- ]EF[ D @

row keys and the

pusbutton, some parame- WﬁZZTfG! @

ters of the CPU can be incorrect | |

confaured i | €9 (D) Tl

explosion. @ 502 LESH

@ 24V DC 1ConL\;

@

D
A

Figure: Configuration on the CPU
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To configure the FBP address, please follow the procedure described below:

1. First select the item to be configured by ETH
pressing the CFG key, the CPU changes to @ sys| I _1_0rniZl  |FBP
configuration mode and a small triangle is BATT| IV VL fcomt
displayed on the LCD on the first right up VO-Bus COM2
position of the display beside the ETH in-
scription and the already configured ad-

is di ETH
dress is displayed. sys C o mma FBP
Press one time more the CFG key to move @ BATT (DR COMH
the triangle to the position below "FBP”. I/O-Bus Ccom2
The FBP is then selected, and the current
address is shown.

2. Press then the arrow keys UP or DOWN to @ ETH
increase or decrease the address, the mo- SYS o i FBP
dified value blinks to indicate that it differs BATT| LI v rs COMt1
from the previously stored one. @ VO-Bus COM2

3. Once the desired address is reached, ETH
press OK to accept and quit or only ESC to sSYS FBP
exit the menu without saving the changes. or BATT |« (NI COMA
The CPU status is then displayed @ I/O-Bus COM2
run/StoP.

A If the FBP address set on the AC500 CPU module is different from those
ATTENTION

assigned into the Fieldbus configurator software of the Master device for that
station, the station could not be accessed and the complete Fieldbus could not
work properly or be completely down!

The modified address will only be valid after a Power OFF / Power ON!

& ATTENTION

A AC500 CPU equipped with a FieldBusPlug is always a slave device on the bus. To act as a master, a
AC500 CPU should be equipped with master couplers (e.g CM572-DP for PROFIBUS DP).

Make the Connection of the FieldBusPlug to the Fieldbus Master Device

The FieldBusPlug module has to be connected to the master device and the power supply has to be
provided. Please use the dedicated accessories to the FBP used for the desired Fieldbus.

Refer to the FBP documentation for the installation instructions.
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Status display and error indication on the AC500 CPU

All AC500 CPUs have LEDs and a LC Display for indicating operating statuses and errors. The following
drawing shows the front face of a AC500 CPU.

=

WARNING!
Use of
incorrect @

battery may

cause fire or

explosion.

1

AAIE PM581

a _ _ _ _ _ _ B> |ETH

sys |«m CHTICHZICND) B [FBP
BATT |«m LU0 By | comit
1/0-Bus |41 B> | com2

PWR RUN ERR i

B o N

MC |=INSERT
(M3 2B

CPU
24V DC 10W

|

The CPU statuses are displayed on the CPU front
face with 3 LEDs:

The display contains the following indications:

and by means of a background-lighted display

B small black squares indications acting as a
LED status for the device written beneath

» small black arrows used for indication by
pointing the selected device to be con-
figured or read

6 x 7-segment displays for “plain text” or

error codes display

Figure: Front face of a AC500 CPU

The display’s background lighting is normally switched off. The status of the CPU is shown as plain text

“run" or "Stop", which reflects the operating status of the CPU program.

By pressing one of the dialog keys "RUN, DIAG, CFG or VAL", the background lighting is turned ON
and the desired function is performed.

In case of a function error, the display background lighting is also switched on and an error code is

displayed.
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The meanings of the LEDs and the LCD display are listed in the following table:

AC500 CPU module LEDs

LED Status Color | LED =ON LED = OFF LED flashes

PWR 24V DC green | voltage is present | voltage is -
power supply missing
is provided

RUN activity status green | CPUisin RUN CPUisin If flashes fast (4 Hz):

mode STOP mode The CPU is
reading/writing the SD
card, indicates together
with the blinking error
LED that the CPU is
writing the internal Flash
EEPROM.
If flashes slow (1 Hz):
The firmware update
from the SD card is
finished without errors.

ERR error indication | red An error has No errors are Flashing fast (4 Hz):

occurred. The encountered or | Indicates together with
error type and only warnings RUN a firmware update
code is displayed | (E4 errors). process and a Flash

in the LC Display. | Thisis EEPROM write.

The error codes configurable

can be shown by (by error 2 - 4,

means of the the LED

DIAG and OK behaviour is

keys. configurable.

m Working black Device is present | No activity or Flashing according to
activity of the and OK (e.g. the device not the device activity, e.g.
beneath battery is present | present when data exchange on
described and OK). ETH, COM1, etc...
device (e.qg. communication lines.
top right of the
display ETH
communication
line).

- Or Indicates the black Points out the No device --
selected selected device selected
device to be of which the
read or name is written
configured. beneath (e.g. top
Acts as a right of the
cursor moving display ETH
with the arrow communication
& ¥ keys line).
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Displaying error messages (error codes) on the AC500 CPU

When an error occurs, the red error LED goes on and an error message is displayed in the LC Display.

By pressing the DIAG key, the complete error code can be shown and an acknowledgement of the error
can be performed.

By using the DIAG and
the OK or the ESC push-
buttons, the error mes-
sage/code can be dis-
played and the error can
be acknowledged.

@9 9 &

a _ _ _ _ _ _ i» | ETH
SYS |« L1101 oy FBP
BATT [«B LU 1y | comt
I/O-Bus [« 1> | com2
PWR RUN ERR B
(N BB om
= 63
WARNING! ' @
Use of @
incorrect @ @
battery may ;lSERT
cause fire or MC =
explosion. @ LPHSH
CPU
24V DC 10W
L 1

Figure: Error display on the CPU

The AC500 CPU can display various errors according to the error classes. The following error classes
are possible. The reaction of the CPU is different for each type of error.

Error class | Type Meaning Example

E1 Fatal error A safe function of the operating system Checksum error in the
is no longer guaranteed. system Flash or RAM error

E2 Severe error | The operating system is functioning Checksum error in the
without problems, but the error-free user Flash, independent of
processing of the user program is no the task duration
longer guaranteed.

E3 Light error It depends on the application, if the user Flash could not be
program should be stopped by the programmed, I/O module
operating system or not. The user has failed.
should decide, which reaction is
necessary.

E4 Warning Error in the periphery (e.g. 1/0) which Short-circuit at an I/O
only can have influence in the future. module, the battery is
The user should decide the reaction to exhausted or not inserted.
provide.

E.U[[B Note: The error messages are displayed as error codes using the Control Builder software (via
PLC browser). Errors are displayed as text in the status line of the Control Builder software or with
function blocks for diagnosis.
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How an error message is built-up in the display

An error always consists of an Error Class (E1 to E4, see the previous table) and a number (0 to 63)
which indicates the identifier of the error for direct error recognition. Moreover, there are further four
detailed error codes from d1 to d4 which define the error in detail:

E1...E4 = 00...63 (error identifier) | e.g. wrong value, checksum error, short-circuit, exhausted or
missing battery, etc. which is directly displayed in the LCD
-> d1 =000...015 indicates the component which has sent the error (coupler, CPU,
COM1, FBP, 10-Bus, etc.)
d2 = 000...255 defines the faulty device within the component
d3 =000...030 defines the part of the module with an error (slot)
d4 = 000...031 defines the channel within the module

Example of an error display for an exhausted battery

To display the complete error codes, please follow the procedure described below:

The CPU is running. The display only shows
the RUN status and the background lighting is
OFF.

When an error occurs, the red ERR LED goes
on. An error message is output after pressing
the DIAG key and, for example, the screen
shown to the right displays "E4=008". Accor-
ding to the error level, E1 to E4 can be dis-
played.

In this example, "E4=008" is a warning (E4)
and ”008” means "Empty/Missing” .

By pressing on the DIAG button, the LCD
background lighting is turned ON, the error
codes can be displayed to achieve more (dea-
per) diagnostic. The display shows "d1=009"
(detail level 1) and "009” indicates that the
CPU has sent the error.

By pressing DIAG one more time, the display
shows "d2=022" (detail level 2) and 022" indi-
cates that the device type = battery.

By pressing DIAG one more time, the display
shows "d3=031" (detail level 3) and "031”
means "no module type” (= device itself).

By pressing DIAG one more time, the display
shows "d4=031" (detail level 4) and "031”
means "no channel” (= device itself).

By pressing OK, the error is acknowledged
and the display returns to the normal state.
ESC returns to the normal state without ack-
nowledging the error!

ETH
SYS _ FBP
BATT |« (I COM1
1/0-Bus COoM2
_ - ETH
sys| C_ g FBP
BATT |4 I_ L) | comt
1/0-Bus CcOoM2
- - - ETH
SYS o _nmng FBP
BATT [« L0 0 _ 0 COMA1
1/0-Bus COoM2
- — - - ETH
SYS D O o B B =T
BATT |« 10 _0C I COM1
/O-Bus COM2
- ETH
sys| A _1131 1 |FBP
BATT(« 1233010701 1 COMH
/O-Bus COM2
- - ETH
SYS i _m1 3 |FBP
BATT [« 10 1_ 100 1) COM
/O-Bus COM2
ETH
SYS _ FBP
or BATT |« Con COMH
@ I/O-Bus CcCOoM2

Figure: Example of an error display for an exhausted battery

Please refer to the Error Code list for further information. See the AC500 user manual.
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LEDs on S500-FBP modules

All S500 modules have LEDs for the display of operating statuses and error messages. They indicate:

LED Meaning Color | LED =ON LED = OFF LED flashes
Input digital input yellow | input=ON input = OFF --
analog input yellow | brightness depends on the value of the --
analog signal
Output digital output yellow | output = ON output = OFF --
analog output yellow | brightness depends on the value of the --
analog signal
upP process green | voltage is present voltage is missing --
voltage 24 V
DC via
terminal
PWR 24 V DC via green | voltage is present voltage is missing --
FBP
S-ERR Sum Error red serious error, data no error error (e.g. error
exchange is on one
stopped, depends channel, data
on the behaviour of exchange is not
the master stopped
FBP FBP green | communication communication during
communication between FBP and between FBP and | initialization
FBP Interface FBP Interface
Module is running Module is broken
I/O-Bus I/O-Bus green | communication no communication | error on one I/O
communication between FBP between FBP expansion
Interface Module Interface Module module (e.g.
and the I/0O and the I/0O one output
modules is running | modules short-circuited)
CH-ERR1 Channel Error, red serious error within no error error on one
CH-ERR2 error red the corresponding channel of the
messages in group corresponding
CH-ERR3 | groups (digital |_ed group (e.g. one
CH-ERR4 | or analog red output short-
inputs and circuited)
outputs
combined into
the groups 1,
2,3,4)
CH-ERR Module Error red error within the 1/0 -- --
) module
*) All of the LEDs CH-ERR1 to CH-ERR4 (as far as they exist) light up together

For the meaning of the different LEDs and their behaviour when the system is running, please refer to
the S500 System Data of the S500 User’s manual for further information.
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FBP LEDs — PROFIBUS DP

H1 and H2 display the PROFIBUS status ——— o m H1 Hz
H3 and H4 display the device status —— [ H | 1 ™
Py T PROFIBUS status

Label for writing down the address setting _@
Fastening screw (provided on delivery) E ﬁ
-1 Maodule status

device status

Meaning of the LEDs

PROFIBUS status

Device status

Status / Cause

LED green | LED red
H1 H2

LED green | LED red
H3 H4

off off

off off

Fower supply is missing

On flashes

Possible errors:

- Mo connection to the bus master, e.g. PROFIBUS not
operating.

- The PDP21 / PDP22 has a slave address that is not
configured in the bus master.

- Parameter length and slave address are correct but 110
configuration of the slave doas not meet the configuration
sent bv the bus master

flashes

The davice parameters received from The bus master are formal
incorrect, e.q. of other length.

off On

Connection to the bus master lis interrupted longer than the time-
out set by the bus mastar before interruption.

On off

Mormal data exchange to the PROFIBUS DP master.

On off

Mormal data exchange to the terminal device.

flashes | flashes

flashes | flashes

Plug is under self-test during power-up

flashes off

Plug is waiting for configuration data, to be sent from the device
(number of input/output bytes, number of parameter bytes,
internal baud rate aetc.).
Mote: If no data has been sent by the terminal device within

3 5, the plug switches to the parallel mode.

off flashes

Error: can be remedied, e.g. connection to the terminal device is
broken.

off

Error: cannot be remedied, e.g. incorrect checksum in the flash.
Exchange plug.
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AC500 Modules Specifications

Please refer to the AC500 User's Manual chapter System Data.

AC500 Modules Certifications

Please refer to the AC500 User's Manual chapter System Data.
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Getting Started with S500-FBP

Important user information

Solid state equipment has operational characteristics differing from those of electromechanical
equipment. Because of this difference, and also because of the wide variety of uses for solid state
equipment, all persons responsible for applying this equipment must satisfy themselves that each
intended application of this equipment is acceptable.

In no event will ABB be responsible or liable for indirect or consequential damages resulting from the use
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the
many variants and requirements associated with any particular installation, ABB cannot assume
responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by ABB with respect to use of information, circuits, equipment, or software
described in this manual.

Throughout this manual we use notes to make you aware of safety considerations.

Identifies information about practices or circumstances that can cause an
explosion in a hazardous environment, which may lead to personal injury or
death, property damage, or economic loss.

Identifies information that is critical for successful application and
understanding of the product.

Identifies information about practices or circumstances that can lead to
personal injury or death, property damage, or economic loss. Attentions help
you:

e identify a hazard

e avoid a hazard

e recognize the consequence

SHOCK HAZARD Labels may be located on or inside the device to alert people that dangerous
voltage may be present.

SHOCK HAZARD Labels may be located on or inside the device to alert people that surfaces may
have dangerous temperatures.

& WARNING

A IMPORTANT

& ATTENTION

Environment and Enclosure Information

A Environment and Enclosure

ATTENTION

This equipment is intended for use in a Pollution Degree 2 industrial
environment, in overvoltage Category Il applications (as defined in IEC
publication 60664-1), at altitudes up to 2000 meters without derating.

This equipment is considered Group 1, Class A industrial equipment according
to IEC/CISPR Publication 11. Without appropriate precautions, there may be
potential difficulties ensuring electromagnetic compatibility in other
environments due to conducted as well as radiated disturbance.

This equipment is supplied as "open type" equipment. It must be mounted
within an enclosure that is suitably designed for those specific environmental
conditions that will be present and appropriately designed to prevent personal
injury resulting from accessibility to live parts. The interior of the enclosure must
be accessible only by the use of a tool. Subsequent sections of this publication
may contain additional information regarding specific enclosure type ratings
that are required to comply with certain product safety certifications.

See NEMA Standards publication 250 and IEC publication 60529, as
applicable, for explanations of the degrees of protection provided by different
types of enclosure. Also, see the appropriate sections in this publication, as
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well as the S500 User's manual for additional installation requirements
pertaining to this equipment.

Before starting

Use this document as a guide for installing and powering-up your S500-FBP Interface Module. You
should already be familiar with the system components.

How to handle S500-FBP components

A ATTENTION

this equipment:

packaging.

Preventing Electrostatic Discharge

This equipment is sensitive to electrostatic discharge, which can cause internal
damage and affect normal operation. Follow these guidelines when you handle

e Touch a grounded object to discharge potential static.

Wear an approved grounding wrist strap.

Do not touch connectors or pins on component boards.

Do not touch circuit components inside the equipment.

If available, use a static-safe workstation.

When not in use, store the equipment in appropriate static-safe

Make sure that you have all the components you need

To use the S500-FBP Interface Module you should use at least the following parts:

Part Number Designation

1SAP220000R0001 DC505-FBP, Interface Module with 8DI/8DC 24 V DC
1SAP210000R0001 or TU505, FBP Terminal Unit with screw or TU506, FBP Terminal Unit with
1SAP212000R0001 spring

See the FBP Catalog

FieldBusPlug module with desired Fieldbus protocol

You may also use these components with the S500-FBP Interface:

If you want to:

Then use this component:

e connect a 24 V dc digital sensor or
actuator to the device

DI524 (32 DI ), DC522 (16DC), DC523 (24DC),
DC532 (16DI/16DC) or DX522 (8DI/8 DO-R) with
the corresponding terminal unit with screw-type or
spring connection TU515/516 or TU531/532

e connecta 115-230 V AC digital sensor or
actuator to the device

DX531 (8Dl 115-230 V AC / 4 DO-R) +
corresponding Terminal Unit TU531/532 with
screw or spring technology

e connecta 24 V DC analog sensor or
actuator to the device

Al523 (16Al U/I/PT100), AO523 (16A0),
AX521(4Al1/4A0 U/I/PT100) or AX522 (8AI/8AO
U/I/PT100) + corresponding Terminal Unit
TU515/516

e Label the I/O Channels

TA523 (Pluggable marking holder) + TA525
Markers for marking holder.
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System planning

Consider the following when planning your S500-FBP system:

The S500-FBP controller is always the left-most module in the system.

The FieldBusPlug delivers the power supply for the FBP interface module DC505 and the connected
I/O bus; the additional I/O modules have to be installed to the right of the FBP Interface Module.
The DC505-FBP Interface module supports as many as 7 1/O expansion modules.

An additional process power supply has to be provided for the I/Os of each module. Each 1/O
expansion module can be powered with its own power supply (isolation purpose) or the same power
supply can also be used.

One FieldBusPlug can be used in a S500-FBP cluster.

Installation steps

<

Installation step: Further
information

1 Snap the FBP Terminal Unit onto DIN Rail or screw it (wall mounting)

2 Snap the additional Terminal Units for I/O modules onto DIN Rail
(optional) or screw them (wall mounting)

3 Make the sensor/actuator wire connections according to the dedicated
Electronic module you want to use (see dedicated pages), connect
also a Process Power supply to the modules.

4 Plug the different Electronic modules in the right place (FBP Interface
module on TU, and eventually also I/O modules onto dedicated TUs)

5 Make the FBP fieldbus connection acc. to the chosen FBP and use the | (¥)
dedicated FBP accessories (cables, master cable to M12, line
termination, power supply connector, etc...)

6 Plug the FBP-Plug on the M12 connector located on the Terminal Unit
of the S500-FBP Interface Module

7 Set the correct address onto the FBP Interface Module (rotary
switches)

8 Install the appropriate EDS/GSD files into the Fieldbus configurator (for
use with AC31 or AC500 Control Builder) or use a dedicated Fieldbus
Configurator tool using GSD/EDS configuration files of your Master
device

9 Set the power on (process power supply first and FBP power supply)

o o0 OO O ol

10 Start the communication

() Refer to the Installation Instructions of the used FBP device.
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Assembling the System

A WARNING

The S500-FBP modules are not designed for removal or insertion under power.
Because of unforeseeable consequences, it is not allowed to plug or unplug
modules with the power being ON.

If you connect or disconnect the FBP plug while power is applied to this module
or the wiring while the process power supply is on, an electrical arc can occur.
This could cause an explosion in hazardous location installations.

Be sure that power is removed or area is non-hazardous before proceeding.

Using S500 I/O Modules

The S500 I/O modules could be used either directly connected to an AC500 CPU (central expansion) or
together with an FBP Interface Module DC505-FBP + an FBP (PROFIBUS DP, DeviceNet, etc.) as
decentralized expansion.
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>
e e 40ohane s :
o o 0
E E AN\E © = 0
a © O 5
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° E:J O OJC O 0o o | (© ojc gjo gjo O
) ol © 0jo gfo gl g | [|© gl gjo g|d o
o| [ ¢ 0jo gfo gjo g | [|© glo gjo g|d o
2 © | |5 oo gjo gio gl | |© g|d g|o g|o o
| S g0 g gio gl | [© gjo g|d g|id o
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Figure: S500 1/0 modules directly connected to an AC500 CPU (central I/O expansion)
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Figure: S500 1/0O modules connected to an FBP Interface Module DC505-FBP with an FBP

(decentralized expansion)
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Minimum spacing
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Figure: AC500/S500 module mounting into cabinets

Maintain spacing from enclosure walls, wireways, adjacent equipment, etc. Allow minimum 20 mm (1 in.)

of space on all sides, as shown. This provides ventilation and electrical isolation.
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A Important: Horizontal mounting is highly recommended. Vertical mounting is possible,
however, derating consideration should be made to avoid problems with poor air circulation and the
potential for excessive temperatures (see also the AC500 system data, operating and ambient
conditions, for reduction of ambient temperature).

d][[g Note: By vertical mounting, always place an end-stop terminal block (e.g. type BADL, P/N:
1SNA399903R0200) at the bottom and on the top of the modules to properly secure the modules.

By high vibration applications and horizontal mounting, we also recommend to place end-stop
terminals at the right and left side of the device to properly secure the modules, e.g. type BADL,
P/N: 1SNA399903R0200.

Mounting the System

A ATTENTION

During panel or DIN rail mounting of all devices, be sure that all debris (metal
chips, wire strands, etc.) is kept from falling into the controller. Debris that falls
into the controller could cause damage while the controller is energized.

Mounting and Demounting of the Terminal Unit and Electronic Module

Mounting on DIN rail

Step 1: Install the 7.5 mm or 15 mm DIN Rail

Step 2: Snap the FBP-Terminal Unit (TU505 or TU506)

(@]
0
S
L] @
~ O gJo o
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O 0|0 O
O 0|0 O
o O 0|0 O
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U O O0 D
| O 0|0 O
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Figure: Mounting of the FBP Terminal Unit (TU505 or TU506)

The FBP Terminal Unit will be placed on top of the DIN Rail and then snapped on the bottom. Follow the
reverse order to disassembly.
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Figure: Disassembly of the FBP Terminal Unit (TU505 or TU506)

Step 3: Mounting of the I/O Terminal Unit (TU515, TU516, TU531 or TU532)
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Figure: /0O Terminal Unit assembly (TU515, TU516, TU531 or TU532)

The I/O Terminal Unit is installed on the DIN rail in the same way as the FBP Terminal Unit. Once
secured on the DIN rail, slide the 1/O unit to the left until it fully locks into place creating a solid
mechanical and electrical connection.

Up to 7 I/0O Terminal Units could be combined with a FBP Terminal Unit.

When attaching the FBP, FBP Interface and I/O modules, make sure the bus

A ATTENTION connectors are securely locked together to ensure proper electrical connection.
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Figure: Maximum configuration (1 FBP Terminal Unit plus 7 I/0O Terminal Units)

Disassembly of a Terminal Unit
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Figure: 1/0 Terminal Unit disassembly (TU515, TU516, TU531 or TU532)

A screwdriver is inserted in the indicated place to separate the Terminal Units.
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Step 4: Module assembly

f

|

Oomoo

Nl
oMo
g L>

o= :
o mh
81> 2

oooooooooo

Ll

mll
:

TOUOTOT

[

o

[e]elelelelelelelele)
jm]m]mm[m[w]n]n]n]]
[e]e]elele]e]0lelele)
00000o000od

Figure: Mounting of the module
The module will be plugged on the Terminal Unit. And will be locked in place.

The disassembly is done in reverse order.
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Figure: Module disassembly

For disassembly, press top and bottom, then pull out the module.
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Panel mounting

If the Terminal Unit should be mounted with screws, a Wall Mounting Accessory TA526 must be inserted
at the rear side first. This plastic part prevents bending of the Terminal Unit while screwing on.

®
1

L4
o

b Holes for
1 Rear view wall mounting

Rear view S

1 2 3

Front view

D0o0ooooogd
[e]e]elele]e]elelele)
Do0o00ooooogd
[e]e]elelo0elelele)
Doooooogogd
0000000000
00000000ogd

0000000000

Figure: Fastening with screws of the Terminal Unit TU516 (as an example)

1 The Wall Mounting Accessory TA526 is snapped on the rear side of the Terminal Unit like a DIN rail.
The arrow points to the right side.

2 Accessory for wall mounting inserted

3 Terminal Unit, fastened with screws. Use two screws per module. Use M4 or #8 pan head screws.
Mounting screws are required on every module.

By wall mounting, the Terminal Unit is earthed through the screws. It is necessary that

e the screws have a conductive surface (e.g. steel zinc-plated or brass nickel-plated)
e the mounting plate is earthed
e the screws have a good electrical contact to the mounting plate

The following procedure allows you to use the assembled modules as a template for drilling holes in the
panel. Due to module mounting hole tolerance, it is important to follow these procedures:

1. On a clean work surface, assemble no more than three modules.

2. Using the assembled modules as a template, carefully mark the center of all module-mounting
holes on the panel.

3. Return the assembled modules to the clean work surface, including any previously mounted
modules.

4. Drill and tap the mounting holes for the recommended M4 or #8 screw.
5. Place the modules back on the panel and check for proper hole alignment.

6. Attach the modules to the panel using the mounting screws.

TIP: If mounting more modules, mount only the last one of this group and put the others aside.
This reduces remounting time during drilling and tapping of the next group.

7. Repeat steps 1 to 6 for any remaining modules.
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Grounding considerations

This product is designed to be mounted to a well-grounded mounting surface such as a metal panel.
Additional grounding connections from the S500 mounting tabs or DIN rail (if used), are not required
unless the mounting surface cannot be grounded. Refer to appropriate Chapter of the S500-FBP User's
Manual, for additional information.

& This product is grounded through the DIN rail to chassis ground. Use zinc
ATTENTION plated yellow-chromate stell DIN rail to assure proper grounding. The use of
other DIN rail materials (e.g. aluminium, plastic, etc.) that can corrode, oxidize,
or are poor conductors, can result in improper or intermittent grounding.

S$500 system dimensions
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O 00 O O 0|0 OJo O|e o )
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135 mm
TU505/506 TU515/516/531/532 (5.31) inches

Figure: Dimensions of the Terminal Unit (front view)
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Dimensions:
135 mm
~ 28 = (1.10) (5.31) inches

View on the left side

View on the right side

Figure: Dimensions of the Terminal Unit with module (lateral view)

Note: All dimensions are in mm (in.). Hole spacing tolerance: +0.4 mm (0.016 in.)
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Setting of the slave address of the FBP plug onto the S500-FBP interface module

The FieldBusPlug needs to get an address to be used into a fieldbus as a slave module. The S500-FBP
Interface Module gives them an address at power-up of the system. The address should be set
according to 2 rotary switches located on the top of the module.

Up to 99 addresses can be then set with the switches.

23,

o@u
6‘8L°:

23,

o@wun
08L°:

PWR O 0O [10 w00 |2 10 10 0] [20 80f [30 cte]] [4.0 caa[]
FBP [ O [ v 0 e 14 1 0| [21 00| [31 c170| |41 ces[]
S-ERR B O |12 =0 (2 12 12 0| [22 1o0| |32 c1e[| |42 ces[]
1/0-Bus [0 O s 10 |2 13 13 0| [23 0| [33 c1e0)| [43 co7[]
0 O |14 0] |2 14 14 | [24 12[0] [34 c2o[]| |44 c2e[]
. . 23, ADDR 0 |15 50| |2 15 15 (| [25 113[| |35 cai[| |45 ceel]
Rotary switch for Settlng 3,:‘: xio O |16 w60 [2 16 16 0| |26 na0| |36 ce2[] |46 cao]
0 17 70 [2 17_17 0| |27 _ns0]| [a7 ces(] [47 cail
the FBP Slave addreSS \2-3' ADDR O |18 up O [2: 0 1.8 up 0| |28 up|(] |38 ur|d |48 ur|O
Seie xi 0 |e zp ! 19 zr|l |29 zp|W [s9 zr|W [49 zp
e - CH-EHH: CH-ERR?T . CH-EHH: CH-EHHET CH-ERRST CH-ERRJ -

A screwdriver with a FBP 801 80 5ol 1600
width of 2.5 mm to 3 mm |:| Ooutput 23V DG 0.5A |:| Ooutput 24V bG 054
is required o —

) DC505  zhibip

Ore][Oz0[] Oe][O2e0||OzeO||O4e]
] O+](O=10 O+O)[O=10||O=: O[O0
] O2[||Oz22[] O2[||O22{|Os2[0||O+200
OulO-0| | [[Oeao-a|0-n]0-a

ADDR - O1.4|:| Oz.4|:| O1.4|:| Oz.4|:| Oa.4|:| O4.4|:|
@ O+s]|Oz2s00 O+s][O2s0||O2sO{|O+s00
X1O O1s||Oz2s0 O1s||O2sO||O2e||O 4600

Ow0||O=70 O+w0||O=7O(|Os70||O+70
Oe||O220 Oe||O2e0{|Oz2e0||O4200
Oe||Oz2e0 Oo||O220{|Ose0||O+200

ADDR i

Figure: Setting the FBP slave address

The two rotary switches labelled ADDR x 1 and ADDR x 10 are used to assign an address to the

FieldBusPlug.

For example: to assign the address 25 to the station, turn the rotary switch ADDRx10 to the position 2
and the ADDRXx1 to the position 5, then the resulting address is 2x10 + 5x1 = 25.

Same example but for the address 6: turn the ADDRx10 to 0 and the ADDRXx1 to 6, then the resulting
address is 0x10 + 6x1 = 6.

& ATTENTION

If the address set on the FBP Interface Module is different from those assigned
into the Fieldbus configurator software of the Master device for that station, the
station could not be accessed and the complete fieldbus could not work
properly or be completely down!

Make the Connection of the FieldBusPlug to the Fieldbus Master Device

The FieldBusPlug module has to be connected to the master device and the power supply has to be
provided. Please use the dedicated accessories to the FBP used for the desired Fieldbus.

Refer to the FBP documentation for the installation instructions.
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LEDs on S500-FBP modules

All S500 modules have LEDs for the display of operating statuses and error messages. They indicate:

LED Meaning Color | LED =ON LED = OFF LED flashes
Input digital input yellow | input = ON input = OFF --
analog input yellow | brightness depends on the value of the --
analog signal
Output digital output yellow | output = ON output = OFF --
analog output yellow | brightness depends on the value of the --
analog signal
upP process green | voltage is present voltage is missing --
voltage 24 V
DC via
terminal
PWR 24V DC via green | voltage is present voltage is missing --
FBP
S-ERR Sum Error red serious error, data no error error (e.g. error
exchange is on one
stopped, depends channel, data
on the behaviour of exchange is not
the master stopped
FBP FBP green | communication communication during
communication between FBP and between FBP and initialization
FBP Interface FBP Interface
Module is running Module is broken
I/O-Bus I/0-Bus green | communication no communication | error on one /O
communication between FBP between FBP expansion
Interface Module Interface Module module (e.g.
and the 1/0 and the 1/0 one output
modules is running | modules short-circuited)
CH-ERRT1 Channel Error, red serious error within | no error error on one
CH-ERR2 error red the corresponding channel of the
messages in group corresponding
CH-ERR3 | groups (digital |_ed group (e.g. one
CH-ERR4 | or analog red output short-
inputs and circuited)
outputs
combined into
the groups 1,
2,3,4)
CH-ERR Module Error red error within the 1/10 -- --
) module
*) All of the LEDs CH-ERR1 to CH-ERR4 (as far as they exist) light up together

For the meaning of the different LEDs and their behaviour when the system is running, please refer to
the S500 System Data of the S500 User’s manual for further information.
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FBP LEDs - PROFIBUS DP

H1 and H2 display the PROFIBUS status —T— O & H1 Hz
H2 and H4 display the device status —— H H ‘\ 1 W

Label for writing down the address setting _%
Fastening screw (provided on delivery)

PROFIBUS status

H3 H4
]

Module status

device status

Meaning of the LEDs

PROFIBUS status

Device status

Status / Cause

LED green
H1

LED red
H2

LED green
H3

LED red
H4

off

off

off

off

Power supply is missing

On

flashes

Possible errors:

- Mo connection to the bus master, e.g. PROFIEUS not
operating.

- The PDP21 / PDP22 has a slave address that is not
configured in the bus master.

- Parameter length and slave address are correct but /O
configuration of the slave does not meet the configuration
sent bv the bus master

flashes

on

The davice parameters received from The bus master are formal
incorrect, e.q. of other length.

off

On

Connection to the bus master lis interrupted longer than the time-
out set by the bus master before interruption.

On

off

Mormal data exchange to the PROFIBUS DP master.

On

off

Mormal data exchange to the terminal device.

flashes

flashes

flashes

flashes

Flug is under seli-test during power-up

flashes

off

Flug is waiting for configuration data, to be sent from the device
(number of input/output bytes, number of parameter bytes,
internal baud rate ete.).
Mote: If no data has been sent by the terminal device within

3 5, the plug switches to the parallel mode.

off

flashes

Error: can be remedied, e.q. connection to the terminal device is
broken.

off

On

Error: cannot be remeadied, e.g. incorrect checksum in the flash.
Exchange plug.
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S$500-FBP Modules Specifications

Please refer to the S500 User's Manual chapter System Data.

S500-FBP Modules Certifications

Please refer to the S500 User's Manual chapter System Data.
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Examples

Examples for introduction

Getting started

We will introduce you to the system using a simple example.

Abl ZIRSL Ak 8 L+ +24VDC UP
Im]n] He — = * L+ +24V DC UP
48ARAAAE I —O MM oV zP
= = O o M oV ZP
0 0 Ol | | FE FE Functional Earth
00 8 o 1
= 0 .2
::,EI:,!:I} O o 3
] SITH &
S oo o a0 o Oll 14 6
E;j O 0|0 Ol oo O Oll o 7
pidnerel o
® || [© glo oo gl o Ofl I 9
o oo glo dlo o
O 0|0 0|0 0|0 O
dllEdiEes]
@ O 0|0 oo o|c-= 124VDC
TK501
—
—
.55555555555555555555§5§.
AR AAAAA A

The following components are required for this example:
¢ One basic unit (e.g. PM581) and one terminal base (e.g. TB511-ETH).

* One digital 1/0 module DC532 (DX522 or DX531 as an alternative) and one I/O terminal unit (e.g.
TU516).

¢ One 24 VDC power supply.
¢ A PC with the programming software PS501 installed.

¢ One cable (TK501) to connect the PC to the basic unit.
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Task: Assign an input signal to an output.

In this example, we are using the programming language FBD.

Preparations

e Connect the PM581 controller to 24 V DC. Connect the DC532 1/0O module to 24 V DC. Connect
the COM?2 interface of the controller to the COM1 interface of the PC or use an USB RS-232
converter and connect it to the USB interface of the PC.

o Start the PS501 software. The project last edited is opened. If necessary, close this project by

selecting "File/Close".

e Familiarize yourself with the main window of the software.

Object organizer

File Edit Project Insert® Extras Online Swindgws

Help

el s T T T~ e I = R R e |

|

0o002fAR
D00S(EMD_WAR

4, PLC_PRG {PRG-FBD)

D0MPROGRAM PLC_PRG

|

1

FOU indices:238 (23%)

0 Errar{s), O Warnings).

| PDUSI B8 Data t_l,lpesl Visualizatinnsl E-; R esu:-un:esl

<| \

Size of uzed data: 603 of 262144 bytes (0. 43%)
Size of uzed retain data: 0 of 32768 hytes (AOQ%)

\
\ Work space

Message window

A ATTENTION

For a correct operation of the system, it is important to completely specify
(configure) the device configuration in the programming software. Otherwise
the system will bring up corresponding error messages! In case of errors,
please refer to the chapter "System Technology / Diagnosis System in AC500"
for required information.
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Creating a new project
Select "File/New".

File Edit Project Insert Extras Online  Window Help

Mew From kemplate. ..
CIpEm. . . Chrl+0
Close

Select the desired CPU in the appearing window. In our example, select PM581.

Target Sekkings

Configuration: Mone j | ] 4 I

Mone
ACHID P51

ACH00 P53

In the appearing window confirm with OK.

Target Sekttings

Configuration:

Target Flatfarm I kdemary La_w:uutl Generall M ebwark; funu:ti-:unalit_l,ll Visualizatinnl

Flatformm: I FowerPC j
Eirst parameter regizter [integer]: LLazt parameter register [integer]: Begizter for returm value [integer]:

GE =] |rio R EE

I | Eloating point processar

™| [rkel byte arder

Default | ok |
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A window appears where you can select the POU name

, type and language. For the name and the type

keep the settings "PLC_PRG" and "Program". Select "FBD" for the language and confirm with "OK".

Name of the new POL: |PLC_PRG
— Type of PO — Language of the PO Cancel
= Program L
" Function Block
™ Function
Beturn Type: 3
[eooL ]| Cler

X
IIIKI
_Cance |

You have now opened a new project.
Note: All necessary libraries are loaded automatically.

% File Edit Project Insett Extras Online  ‘Window Help

2= B

Lol B|S|SAGR| & [Pl 0= -]

- 0o [:'F{DGRAM PLZ_FPRG
'a F'|_||_|:E: DDDE l'\"I-'E'-H
-] PLC_PRG [PRG) 0003[EMD_VAR
annd
[ <
oot
??? .......

Saving the project to the PC

First of all save the project by selecting the menu item "File/Save as".

File Edit Project Insert Exktras Online  ‘Window Help

IS
Mews From template. .

Cpen... Chrl+0
Close
Save Chrl+5

Save/Mail Archive. ..

Print Chrl+P
Primket Setup. ..
Exit Alb+F4

1 CProgram Filest3s SoftwarehCoDesSys Y2, 3\Projects) Test, pro
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Select the desired directory and enter the project name. Complete your input with "Save".

2l x|

Save in:la Frojects j i £ B9~

File name: |First_5teps Save I
Save as type: IEDDeSys Project [*.pra) j Cancel |

Edit izenze infia.. |

In our example the project is saved under the name "First_Steps" to the folder "Projects". The file

extension "pro" is automatically created by the software.

Specifying the hardware configuration

The software has to be informed about the hardware configuration, i.e. the hardware configuration has to

be specified in the software (e.g. the 1/0 devices). Click on 320 Resources

% File Edit Project Insert Extras ©nline ‘Window Help

BB B]ee 0SS ¥ 5085
% Resources

-] Global Variables

1 library lecsfc.lib 26.11.02 10:23:26: global variables
H-(_ library standard.lib 22.11.02 11:08:30: global variables
- library 5vSLIBCALLEACK. LIB 29.8.02 16:12:56: global variables
-] library SpsLibkem lib 23.8.02 16:12:56: global variables
1 library SysLibTime.lib 29.8.02 16:12:58: global variables
2 | library SypsT azklnfo lib 23.8.02 16:12:58: global wanables
-] library UtiLIb 12.2.04 12:39:58: global variables

- (5] Tool:

Alarm configuration

""" m] Library Manager

..... m LI:IQ

----- @ FLC - Browzer

----- PLC Canfiguration

----- Sampling Trace

----- ﬁ Target Settings

----- Tazk configuration

----- Q W atch- and Recipe Manager
----- ‘}@ WWorkspace

PDUSI B2 Data t_l,lpesl ‘u’isualizatinnsl % Hesnurcesl

| ey (RN ey O oy O oy RN e O oy Y ey (Y oy (O s |
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Double click the object "PLC Configuration”. If the AC500 folder in the PLC configuration tree is closed,
click on the @ symbol.

File Edit Project Insert Extras Online  ‘Window Help

28| 1B)|@]00F|Ss|So{Gh] /B
Tﬂ—, Resources
B Global Variables
&[] library lecsfe.lib 26.11.02 10:23: 26 global variables
B[ library standard.ib 22.11.02 11:08:30: global variables
2 | library SY'SLIBCALLBACK LIB 23.8.02 16:12:56: global variables
&[] library SvsLibbem lib 29.8.02 16:12:56; global variables
B[ library SysLibTime. b 29.8.02 16:12:58 global variables
B[] library SysTaskinfo.lib 29.8.02 16:12:58: global variables
B[ fibwary LD 12.2.04 12:39:58: global variables
b (5] Tools
Alarr configuration
Library banager

----- Sampling Trace

----- ﬁ Target Settings

----- Tazk configuration

----- Qb Whatch- and Recipe Manager

Click on "I/O-Bus[FIX]" and then press the right mouse button.

""" ‘}@ Whorkspace

fEf0-Bus[FIx]
Interfaces(Fl<]
gl Couplers(FIx

Inserk Element

append Subelement k
Replace element

alculate addresses

Export module. ..
Import module, ..

ZLk ]+
Copy k|12
Paste ZEE[ Y
Delete [el

IIO-EILIS[FI}“U
: InterfacesFlx]
....... @ Couplers[Flx]
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Select "Append Subelement" -> "DC532" (or the 1/0 module You use).

- Efj ACS00 i’

kodule parameters |

- e Interfaces(Fl] In... | Name
....... @l Couplers(Fi 1 Run on config fault

Insert Element I
append Subelement DIS24 - 32 digital Input. ..

Replace element DC53Z - 16 digital Input and 16 digital Inoukput, .,
Calculate addresses D522 - 8 digital Input and 8 digital Oukpuk (R, ..
%531 - & digital Input and 4 digital Oukpuk (R, ..
Ax522 - 8 analog Input and & analog Oukpuk, .,

Export module. .

Impart module, .

Zuk ]+
Copy Ckrl+iC
Paste Zhr{
Delete mel

Configuring the digital I/0 module DC 532

Configuring the I/O parameters

Click ond2a Riesaurces, Double click the object "PLC Configuration". By clicking on the 1/0 symbol, the
module parameters are displayed and can be changed. Example for DC532: The input delay is changed
from 8 ms (default) to 1 ms.

B[] ACS00 ﬂ

CF'U parameters[F<] Mc'du'EparamEtersl

B~ [ 10-Bus[FIx]

N - T DCA32 - 16 digital

: = gt Index IName |value Defa

"""" @ Interfaces(Flx] 2 lgnore madule Mo [=|Ma

------- @ Couplars[FIx] 4 Check supply on = |0n
A Input delay Im vl g ms
B Fast counter ra— 0-rMo
7 Detection shart circuit at outputs ms On
a Behaviour outputs at communication ... off
] Suhstitute Value 1]

This way you can also configure the inputs and outputs of the S500-FBP interface module DC505-FBP
in order to use them as decentralized inputs and outputs.
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First click on the E symbol in front of the entry "DC532" and then click on this symbol in front of the entry

"Digital Inputs 0-15[FIX]". The 1/O address mapping in the CPU is displayed:

......... cpu pararmeters[F1x)
&l [ O-Bus[F 1]

&[] Digital Inputs 0-1

B DCE32 - 16 digital Input and 16 digital InoutputlVAR]

a[FI¥]

--------- M| AT %IW0: WORD; (% Input D-15 =) [CHANN

--------- |E| AT %1400
--------- |E| AT %1H01:

--------- AT %1402

--------- |E| AT %1X0.3:

--------- AT %1404

--------- |E| AT %1X0.5:

--------- AT %106

--------- |E| AT %IH0.7:

......... |E| AT %1

......... AT %=1

.0
A
--------- (1] AT %Ix1.2:
......... AT %13
--------- (1] AT %Ix1.4:

A

6

......... AT %=1

......... |E| AT %1

--------- AT %17

- [ Fast counter(FI¥]

--------- M| AT %IB0: BYTE; (" Input 0-7 *) [CHANNEL

BOOL; * lnput 0% [CHAMMEL
BOOL; * lnput 1 %) [CHAMMEL
BOOL; * lnput 2% [CHAMMEL
BOOL; * Input 3 %) [CHAMMEL
BOOL; * Input 4 * [CHAMMEL
BOOL; * Input 5% [CHAMMEL
BOOL; * lnput & * [CHAMMEL
BOOL; * lnput 7 *) [CHANMMEL

--------- AT %IB1: BYTE, * Input 815 * [CHANMNEL

BOOL,; £ Input § # [CHARNMNEL
BOOL; ¢ Input 9 % [CHANMEL
BOOL; ¢ Input 10 %) [CHANMNE
BOOL: ¢ Input 11 % [CHANME
BOOL,; ¢ Input 12 * [CHANME
BOOL: ¢ Input 13 % [CHANME
BOOL; ¢ Input 14 % [CHANNE
BOOL: ¢ Input 15 %) [CHANME

B ﬂ Digital InMutputs - Inputs 16-31[F 1]
B Digital InfQutputs - outputs 16-31[F1X]

= n

In our example, it is possible to access the digital inputs of the DC532 module as word using the address
%IWO0 (simultaneous access to the 16 inputs 10...115) or as bytes (inputs 0 - 7 using the address %IBO0,
inputs 18 - 115 using the address %IB1) or as individual bits (addresses %I1X0.0 to %IX0.7 for inputs 10 -

17 or %IX1.0 to %IX1.7 for the inputs I8 -

[15).

& ATTENTION

In our example, the DC532 I/O expansion module used has digital inputs
and also digital configurable inputs/outputs. These configurable 1/Os are
displayed in the 1/0O mapping either as inputs or as outputs according to

how the channel will be used by the user!
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& 7 NO-Bus[Fl]

& DC532 - 16 digital Input and 16 digital InoutputfAR]

B ﬂ Digital Infoutputs - Inputs 16-31[F ]

--------- P3)LAT %M1 WORD; (* Input 16-31 %) [CHANNEL

......... (3] AT %Ix2.0:
--------- (1] AT %Ix2.1:
......... (3] AT %lx2.2:
--------- (1] AT %Ix2.3:
......... (3] AT %lx2.4:
--------- (1] AT %Ix2.5:
......... (3] AT %IH2.6:
--------- (1] AT %lH2.T:

--------- @ AT %lx3.0;
......... (3] AT %Ix3.1:
--------- E AT %lx3.2:
......... (3] AT %I%3.3:
--------- E AT %lx3.4;
--------- (3] AT %Ix3.5:
--------- E AT %l3.6:
--------- (3] AT %IH3.T:

=1

- [ Fast counter[F ]

--------- MY AT %IB2: BYTE; (" Input 16-23 *) [GHANMEL {f)

BOOL (* Input 16 %) [CHANNEL ()]
BOOL; (* Input 17 *) [CHAMNEL ()]
BOOL (* Input 18 %) [CHANNEL ()]
BOOL (* Input 19 %) [CHAMNEL ()]
BOOL (* Input 20 %) [CHANNEL ()]
BOOL; (* Input 21 #) [CHAMNEL ()]
BOOL (* Input 22 %) [CHAMMNEL ()]
BOOL; (* Input 23 #) [CHAMNEL ()]

--------- P4 AT %I1B3: BYTE; (* Input 24-31 %) [CHANNEL {1

BOOL; (* Input 24 #) [CHAMNEL ()]
BOOL; {* Input 25 % [CHANNEL ()]
BOOL; (* Input 26 *) [CHAMMNEL ()]
BOOL; {* Input 27 # [CHANNEL ()]
BOOL; (* Input 28 *) [CHAMNEL ()]
BOOL; {* Input 28 %) [CHANNEL ()]
BOOL; (* Input 30 %) [CHAMNEL ()]
BOOL; {* Input 31 %) [CHANNEL ()]

- Digital InfOutputs - outputs 16-31[F ]
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The 1/Os will have the following CPU addresses in the CPU mapping table:

Channels

Address in
the mapping /
programming

Comment

software

Digital inputs 0-15 %IWO0 All the 16 digital inputs combined as Word from the
DC532 module

Digital inputs 0-7 %IB0 All the 8 first digital inputs combined as Byte
Digital inputs 8-15 %IB1 All the 8 following digital inputs combined as Byte
Single digital input O %IX0.0 Single digital input as a bit for the input 0 to the input 7
to to
single digital input 7 %IX0.7
Single digital input 8 %IX1.0 Single digital input as a bit for the input 8 to the input 15
to to
single digital input 15 %lIX1.7
Digital configurable %lW1 All the 16 digital configurable I/Os as inputs in combined
inputs 16-31 as Word from the DC532 module
Digital configurable %IB2 All the 8 following digital configurable I/Os as inputs
inputs 16-23 combined as Byte
Digital configurable %IB3 All the 8 following digital configurable 1/Os as inputs
inputs 24-31 combined as Byte
Single digital %IX2.0 Single digital configurable 1/Os as input as a bit for the
configurable input 16 input 16 to the input 23
to to
single digital
configurable input 23 %IX2.7
Single digital %IX3.0 Single digital configurable 1/Os as input as a bit for the
configurable input 24 input 24 to the input 31
to to
single digital
configurable input 31 %IX3.7
Digital configurable %QWO0 All the 16 digital configurable I/Os as outputs combined
outputs 16-31 as Word from the DC532 module
Digital configurable %QB0 All the 8 following digital configurable 1/Os as outputs
outputs 16-23 combined as Byte
Digital configurable %QB1 All the 8 following digital configurable I/Os as outputs
outputs 24-31 combined as Byte
Single digital %QX0.0 Single digital configurable I/Os as output as a bit for the
configurable output 16 output 16 to the output 23
to to
single digital
configurable output 23 %QX0.7
Single digital %QX1.0 Single digital configurable I/Os as output as a bit for the
configurable output 24 output 24 to the output 31
to to
single digital
configurable output 31 %QX1.7

For more details concerning the 1/0 mapping, please refer to the AC500 User's manual.
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Symbolic names for I/Os

In our example we use one digital input and one digital output. We want to label them with symbolic
names. Proceed as follows: Click on the E symbol in front of "DC532" in order to display the 1/O
configuration:

......... = CPU parameters[FIx]
& [ NO-Bus [F 1]
- L2532 - 16 digital Input and 16 digital Inoutputf@aR]
....... Digital Inputs 0-15[F 1]
....... Digital InfOutputs - Inputs 16-31[F 1]
....... Digital InfOutputs - outputs 16-31[F 1]
------- Fast caunter]FI]
& Interfaces[Flx]
G- ﬂ Couplers[FI<]

Now define a symbolic name for the digital input (digital input 0) as follows. First click on the E symbol in
front of "Digital Inputs 0-15[FIX]":

& [ NO-Bus[FIx]

= DC532 - 16 digital Input and 16 digital InoutputfAR]

- [¥] :Digital Inputs 0-15[F 1]

--------- P3| AT %0 WORD; (% Input 0-15 =) [CHANNEL (1)
......... ﬂ AT %1B0: BYTE, (* Input 0-7 *) [CHAMMEL ()]
--------- (3] AT %I0x0.0: BOOL, (% Input 0 %) [CHANMEL ()]
--------- (2] AT %I0x0.1: BOOL; (* Input 1 %) [CHANNEL ()
--------- (3] AT %I1x0.2: BOOL, (* Input 2 #) [CHANMEL ()
--------- (2] AT %I0x0.3: BOOL; (* Input 3 *) [CHANNEL ()

In the line of input O, click twice on "AT". Then enter the symbolic name, e.g. 10dig.

ﬂ Digital Inputs 0-148[F <]
--------- AT %IW0 WORD: (* Input 0-15 %) [CHAMMEL (1Y
I’Wﬂ AT %IB0D: BYTE; * Input 0-7 *) [CHAMREL (1]

[y 10dig b1¢0.0: BOOL, (* Input 0 *) [CHANMEL ¢
— AT %0X0.1: BOOL; {* Input 1 %) [CHANNMEL (1]

Complete your input by pressing the <Enter> key (displayed entry: 10dig AT %IX0.0 ...). Now the
program can access this input by its symbolic name. Using the same procedure, we then have to label
the digital output with a symbolic name. Click on the [E symbol in front of the entry "Digital In/Outputs -
outputs 16-31 [FIX]".

EI ------- @EDigital Infutpots - outputs 16-31[F 1]

--------- AT S0 WORD: * Cutput 16-31 ) [CHARREL (23]
--------- AT %QB0: BYTE; (* Qutput 16-23 %) [CHARNMEL {21)]
AT %00 BOOL, & Output 16 *) [CHARMMEL (2]
--------- AT %R0 BOOL, & Output 17 *) [CHARMEL (2]
--------- AT %002 BOOL, & Output 18 *) [CHARMMEL (2]
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In the line of output 16, click twice on "AT". Then enter the symbolic name, e.g. O0dig, and complete
your input by pressing <Enter>.

. AT %OWO: WORD; ¢ Output 16-31 %) [CHANMEL ()]
AT %QBE0: BYTE, (* Output 16-23 % [CHAMNMEL (G)]

- [ |:00dig AT %GD.0: BOOL, (* Output 16 *) [CHANNEL ()]
- [#] AT %GX0.1: BOOL; {* Output 17 *) [CHANNEL (2)]

Opening the Function Block Diagram editor

From the Resources we now want to switch to the Function Block Diagram editor: Click on the POUs
tab and then double click on the entry PLC_PRG (PRG). The Function Block Diagram editor is opened.

QoM (FROGRAM PLC_FPRG
noozfvAR
0O003EMD_WAR

nond
T

0ao1

Position the mouse cursor into the insertion mark ... of network "0001" and press the right mouse
button. Select "Assign".

Cuk Chel+3
Copy Chel+C
Paste ChElY
Delete Del
Metwork (before)

Metwork (after)  Cerl4-T

Input Zhel L
Otput:
Bo:x Ckrl+EB
Assign
Jump Zkrl+L
Return CErlH-R

The display is as follows:

iy

e

Now we have to enter the symbolic names previously assigned to the input and the output. Click on the
left-hand question marks (??7?) and press <F2>. The Help Manager appears. Select "System Variables".
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Help Manager

Laocal Y ariables
| Global VY ariables
iSustermn YW arnables

O0dig

Eann:el

Select "l0dig" and confirm with "OK". Proceed in the same way for the output. At the end, click into the
free area of network "0001".

0oo1

|0 dig——00dig!

Compiling the project

The definition of the project is now completed and the project can be built. For this purpose, select the
menu item "Project/Rebuild all”.

Projeck  Imsert Extras  Online  WWindow

Build Fll
Rebuild all
Clean all

Load download information. .

If no errors were detected, the message "0 errors, 0 warnings" is displayed in the message box.
Setting the communication parameters

In order to establish the connection between the PLC and the PC, the communication parameters have
to be set. We are using the COM2 interface of the PLC and the COM1 interface of the PC or the COM

interface of the PC assigned by the USB RS-232 converter. Switch to the 3% Resaurces tab. Double click

the object "PLC Configuration”. In the configuration tree, click on the E symbol in front of the
"Interfaces[FIX]" element.

......... CPU parametersFl]
B [ F0-Bus[F 4]
- Interfaces[Flx]

e 3 COMT - Onling access[SLOT]
[0 COMZ - Online access[SLOT]
fo (7 FBP - none[SLOT]

&g Couplers[Flx]
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Click on the entry "COM2 - Online access[SLOT]" in order to display the default values of the PLC's

COM?2 interface.

M odule parameters I

Indesx | Marme I*-falue Default | hir. E=
11 Baudrate 19200 =|19200

12 Parity nane x|none

13 Drata bits 8 ol 1

14 Stop hits 1 =11

Then we have to define the PC interface settings. Select the menu item "Online/Communication
Parameters".

Online Window  Help

Login alk+Fs
[mgaut Chr|+FE
Dawmlaad

R =)

Stop Shift+F&
Resek

Reset foold)

Reset foriginal)

Togale Breakpoink Fa
Breakpoint Dialog

step aver FLo
Step in ]
Single Cyele (Zhr[H-F5
Write Values L
Farce Yalues F7.
Release Farce ShifEHET.
Wirite/Farce-Dialog Chrl+ShifE+ET
Show Call Skack. ..

Display: Flaw Eantrol

Simulation Mode

Carmmunication Paramekers. ..
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In the "Communication Parameters" dialog, click on the "Gateway" button and then select the entry
"Local" from the "Connection" list box in the appearing dialog. Then confirm your settings with "OK".

Communication Parameters

— Channels

= Lozal

M ame | " alue I Comment

Connection: |7 -

Sddress;

lozalkiost j

Fart:

Faszword: I

|12'IEI

Communication Parameters: Gateway 5[

Cancel

di

]

Cancel

e

Remowve

[Fateway ...

el

|lpdate

Now the "Communication Parameters" dialog displays the PC interface. Press the "New" button. Enter
any name for the new channel, e.g. COM1_PC, and select "Serial [RS232]" for the "Device" (driver).

Communication Parameters

— Channels

= Local I

M arme

| W allie | Comment

Communication Paramekters: New Channel

Name II:EIM1_F'E

Device

H ame

| Info :l

Senal [R5232. 8 bit]
Topdlp [Level 2]
Seral [Modem)

Pipe

CaMopen DSF302
AS| Contraller

o T

35 Senal RS 237 div
35 Senial R5237 driv
35 Tepdp level 2 dii
35 Modem driver

35 Pipe driver

35 CAMopen DSP3

35 ASI Eu:untn:uller_lll
1 >

Cancel

didl
el el

]

Cancel

M e

Remove

Gateway ...

Ilpdate

Confirm your settings with "OK".
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Now we have to specify the corresponding parameters in the "Communication Parameters" dialog.
Specify the serial interface of the PC with the parameter "Port": double click on the value of “Port”,
possibly several times. Click on the "Baudrate" value and then double click the value until "19200" is
displayed. Proceed in the same way to change the "Motorola byteorder" setting from "No" to "Yes".
Confirm your settings with "OK".

Communication Parameters

— Channels
k.

= Local |serial (R5232) |

i COM1_PC c |
M arme | Walle | Comment | ance
Port COr1
B audrate 19200
Parity Mo P e
Stop bitz 1

otorola byteorder R emowve

[3ateway ...

[

|lpdate

Testing the program with PLC hardware connected

Proceed as follows to test the program with PLC hardware connected:

Downloading the program to the PLC

First we have to load the program to the controller. To do this, select the menu item "Online/Login".

Orfine  Window  Help

! Login
[ogaub CLr|+FE

The software checks whether the project on the PLC is identical to the project on the PC. If the PLC
does not yet contain a user program, the message "No program available in the controller. Should the
new program be loaded" is displayed. If the project on the PLC differs from the project on the PC, the
following message is displayed:

The program haz changed! Download the new program?

Yes Ma Cancel Detailz »»

Select "Yes". Then the program is downloaded from the PC to the PLC. When starting the download
process, the PLC changes to the STOP mode.
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Now we are going to store our program in the Flash memory of the PLC to protect it against voltage

breakdown. To do so, select "Online/Create boot project".

Onfine  Window  Help

LLagir alt+-Fa
Logouk Ckrl+F&
Cawnload

] 5

Skop Shift+Fa
Reset

Reset (cold)

Reset (original)

Toggle Breakpoink Fa
Breakpoint Dialog

step aver Lo
Stepin &
Single Cycle Ckrl+F5
Wilrike Yalues Zkr+F7
Force Yalues F7
Release Faorce Shift+F7
Write/Force-Dialog Zkrl+Shift+F7

Shiowe Call Stack, ..

Display Flow Conkraol

Simulation Mode

Cammunication Paramekers. ..
Sourcecode download

Create book project

Wtrite File bo PLC
Read file From PLC

Starting the program

Now we want to run the program. Select the menu item "Online/Run":

Online  Window  Help

LLagir ot | SR
Logouk Ckrl+F&
Deawnlaad

Stop

Reset

Reset {cold)
Reset (original)

ShifEHFa

In order to test the program we are going to force input 10dig to TRUE: Double click to the input "l0dig":
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In order to set this value permanently, the Force function has to be used. With this function, the user
defined value is set in the runtime system each time at the beginning and at the end of the program
cycle.

Online Window  Help

Login alE-HES
Logouk Chrl+F&
Deawnlaad

R =]
Skop Shift+F&
Reset

Reset {cold)

Reset (original)

Toggle Breakpoint Fa
Breakpoink Dialog

Step aver FLo
Step in F&
Single Cycle kr+F5
Wirike Yalues Zkr+F7

Force Walues F7 I
Release Faorce Shift+F7
Wiite/Farce-Dialog Ckrl+Shift+F7

This way, the input is assigned to the output (i.e. set to TRUE) in each program cycle. The CoDeSys
software displays the TRUE state in blue color (the FALSE state is displayed in black).

I-—c'ndg

This way, the input 10dig is assigned to output O0dig.
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Note: The status of the I/Os can also be displayed in the PLC configuration. Click on 324 Resources
Double click on “PLC configuration”.

B 10-Bus[FI¥]
B DC532

- 16 digital Input and 16 digital InoutputfFAR]

=--["Y]:D

igital Inputs 0-14[F1x]

& E'D
= - ED—JD

i

ﬂ AT %0 WORD,; (* Input 0-15 *) [CHARMMEL ()] = 256
ﬂ AT %IB0: BYTE; (* Input 0-7 *) [CHARMMEL (3] =1

[ | E| 0dig AT %0=0.0: BOOL, (* Input 0*) [CHAMBMEL {13
] E| AT %401 BOOL, % Input 1 *) [CHAMMEL (3]

[] E| AT %102 BOOL, (* Input 2 *) [CHAMMEL {13]

] E| AT %103 BOOL, % Input 3 *) [CHAMMEL (3]

[] E| AT %I140.4: BOOL, (* Input 4 *) [CHAMMEL {13]

] E| AT %08 BOOL, * Input 8 *) [CHAMMEL (3]

[] E| AT %I0.6: BOOL, (* Input 6 *) [CHAMMEL {13]

] E| AT %407 BOOL, % Input T *) [CHAMMEL (3]

ﬂ AT %IB1; BYTE; (* Input 8-15*) [CHAMMEL ()] =0

] E| AT %100 BOOL, % Input 8 *) [CHAMMEL (3]

[] E| AT %1411 BOOL, (% Input 9% [CHAMMEL (13]

] E| AT %l:1.2: BOOL, (% Input 10 *) [CHARMEL (]

[] E| AT %413 BOOL, (% Input 11 %) [CHARMEL ()]

] E| AT %14 BOOL, (FInput 12 ) [CHARMEL (]

A BOOL; & Inpat 13 *) [CHARBMEL (3]

B BOOL; & Input 14 %) [CHARMEL (3]

[] |E| AT %1 .7 BOOL, *Input 15 %) [CHANMEL ()]
igital InfQutputs - Inputs 168-31[F 1]

igital Infutputs - outputs 16-31[F 1]

AT %o 0 WORD, (* Output 16-31 %) [CHAMMEL (2] = 256
AT %QB0: BYTE; (* Qutput 16-23 %) [CHARMMEL (G =1
[ | |Z| O0dig AT %G00 BOOL, * Qutput 16 *) [CHARMMEL (1))
[] |Z| AT %QX01: BOOL, * Qutput 17 *) [CHARMMEL (G
] |Z| AT %0X0.2: BOOL, * Qutput 18 *) [CHARMMEL (1))
[] |Z| AT % QX0 3 BOOL, * Cutput 19 *) [CHARMMEL (G1)]
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Using "Online/Logout", the connection to the PLC is disconnected and the Force function is canceled. To
exit the CoDeSys software, select the menu item "File/Exit".

File Edit Project Insert Extras ©Online ‘Window Help

Mew

Mew From kemplate. ..
Qpen... ChrH

Close

Save Chrl+5

SEVE 85, ..
SaweMail Grehive, .,

Brimt kel 4R
Primber Setup...

Alt+F4
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Examples for decentralized systems connected by network
On principle, the configuration of decentralized systems connected by network is done in two steps:

e The CPU has to be informed about which couplers are assigned to it (internal and/or external
couplers).

* The couplers have to be informed about which peripheral devices are connected to them.

This is done using the tool SYCON.net (opened via the tab Resources -> Tools -> SYCON.net). This tool
is also used to create the variables lists for the individual peripheral devices. The symbolic names
created therein are directly (online) made available for the programming software. Thus, these created
variables are located in the Global Variables folder.

Example with an AC500 CPU PM581 as PROFIBUS DP Master and a DC505-FBP as
PROFIBUS DP slave with a FieldBusPlug PDP22-FBP

AC500 PM581-ETH + CM572-DP as
master + DC532 + AX522

]

o=+ 24V DC

1 I
| 0000- |Z
0600~ | &

0o0oo0oooog

PDA11-FBP.050 i

X I— from COM2/PLC to PC
+/—24 V DC +/—24V DC

Al DC505 AlB DC532 ABB AX522
6]

A
“¥ oomao
oooooooooo| |

i

ooo

PDP22
-FBP

'VEN!-'Io‘lo'loiti-'lo'ri
l@OO0000000)

0000000000,

0000000000

DC505-FBP + DC532 + AX522
-<— PDR11-FBP.150

Figure: Example with an AC500 CPU as PROFIBUS DP master and a DC505-FBP as PROFIBUS DP
slave. Note: “to PC” — either COM1 interface of PC, directly, or corresponding COM interface of PC,
allocated via USB RS-232 converter.

The following example will guide you through the installation and the configuration of a small PROFIBUS
DP fieldbus using an AC500 PLC as PROFIBUS DP master and a S500-FBP remote I/O station with a
modular FBP.
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This example could be used as starting point to develop your own application.

&[[g ATTENTION

Refer to the dedicated User's manuals or Installation guides of the
FieldBusPlug and the AC500 PLCs and programming software.

Needed products

amount

product description

order number

1

PM581-ETH, CPU

1SAP 1401 00 R0170

1

CM572-DP, Communication Module PROFIBUS DP
Master 12 Mb/s

1SAP 170 200 RO0O01

TB521-ETH, CPU Terminal Base AC500, 1x CPU Slot,
2x Coupler Slots, Ethernet RJ45 Connector

1SAP 1121 00 R0170

TA524, Dummy Coupler Module

1SAP 1806 00 R0O001

TK501, Programming Cable, D-Sub / D-Sub

1SAP 1802 00 RO0O01

PDA11-FBP.050, Adapter M12-Dsub9-M12, cable length
0.50 m (field bus + power supply)

1SAJ 9240 09 R0O005

PDP22-FBP.050 PROFIBUS DP-V0/V1-FBP 0.5 m,
modular (FieldBusPlug)

1SAJ 2401 00 R1005

PDR11-FBP.150 Terminating resistor 150 Ohm

1SAJ 9240 07 R0O001

DC505-FBP with 8DI/8DC

1SAP 2200 00 R00O01

DC532 with 16DI/16DC

1SAP 2401 00 RO0O1

AX522 with 8AI/BAO

1SAP 2500 00 RO0O01

TU506, FBP Terminal Unit, Spring Terminals

1SAP 2100 00 RO0O1

TU516, I/0 Terminal Unit, 24 V DC, Spring Terminals

1SAP 2120 00 RO001

GSD file for FBP module

ABB_091F.GSD

CEEEEEEE & EEE ) EE

PS501-PROG, Control Builder AC500, Programming
Software

1SAP 1901 00 RO0O1

Before starting with the following example, please:

e Use the previous installation instructions to assemble and mount the system, also refer to the
dedicated Users manual of the PROFIBUS DP FBP, S500-FBP and AC500 PLCs.

e Make the wiring and provide supply power to the system (process supply) and to the FieldBusPlug
(use dedicated accessory, e.g. PDA11-FBP.050 which allows connecting a PROFIBUS DP master
with a 9 pins D-Sub and provides power supply for the FBP through a M12 connector).

e Set the slave address of the FBP to 2 with the front rotary switches of the S500 FBP-Interface

module (chos

en for this example; see also S500-FBP Getting started).

Install the AC500 Control Builder programming software for AC500 PLCs
Install the SYCON.net fieldbus configurator
Install GSD and EDS files

Connect the programming cable TK501 from the PC to the AC500 PLC
Review all of the hardware instructions for your specific system to be sure you have completed all of

the required preliminary steps prior to beginning the system configuration with the AC500 Control
Builder programming software.

Power up the system
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Starting the programming software

Start the AC500 Control Builder programming software. Select "File/New" to create a new project.

File Edit Project Insert Extras Online  Window Help

Mew From kemplate. ..
CIpEm. . . Chrl+0
Close

Select the desired CPU in the appearing window. In our example, select PM581.

Target Settings

Configuratiorn: Mone j | 0k, I

Maone
ACHID P57

ACH00 PM531

In the appearing window confirm with "OK".

Target Sekttings

Configuration:

Target Flatfarm I kdemary La_w:uutl Generall M ebwark; funu:ti-:unalit_l,ll Visualizatinnl

Flatformm: I FowerPC j
Eirst parameter regizter [integer]: LLazt parameter register [integer]: Begizter for returm value [integer]:

GE =] |rio R EE

I | Eloating point processar

™| [rkel byte arder

Default | ok |
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A window appears where you can select the POU name, type and language. For the name and the type
keep the settings "PLC_PRG" and "Program". Select "ST" for the language and confirm with "OK".

vewPou X
M arme of the new POL: IF'LE_F'HG k. I

— Twpe of POL —Language of the POL Cancel
* Pragram L
" Function Block LD
" Function " FBD
Return Type: " SFC
EGE || ®s
" CFC

The ST editor is opened.

D00 PROGREAM PLC_FPRG
0002vAR
OO003(EMD_WAR

Onndl

4

First, save the project under a specific name. Select the menu item "File/Save as".

File Edit Project Insert Extras ©nline  ‘Window Help

M
Mew From template. ..

QpEr, ., Chrl+0
Close
Save Chrl+5

Save/Mail Archive. ..

Prink Ckrl+P
Prinkter Setup...
Exit Alb+F4

1 C:\Program Filest3s SaftwarehCoDesSys Y2, 3\ Projects) Test, pra

Select the desired directory and enter the project name (in our example: "Test3"). Complete your input

with "Save".
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Specifying the hardware configuration

The software has to be informed about the hardware configuration, i.e. the hardware configuration has to

be specified in the software. Click on i Resources

% File Edit Project Insert Extras Online  Window  Help

2|=|E| 0| @00 EE 2T * [5] 5]/

% Resources
-] Global Variables

-] library lecsfo lib 26.11.02 10:23: 26: global wariables

-] librany standard. lib 22.11.02 11:08: 30: global variables

- library S7SLIBCALLBACK LIE 29.8.02 16:12:56: global variables
2 | library SpsLibMem ib 29.8.02 16:12:56: global vaniables

- library SysLibTime.lib 29.8.02 16:12:58; global variables

-] librany SpsT asklnfo lib 23.8.02 16:12:58: global variables

-] library tiLlib 12.2.04 12:39:58: global variables

- (5] Tools

Alarm configuration

""" ﬁ] Library banager

..... m Ll:lg

----- PLC - Browszer
----- PLC Configuration
----- @ Sampling Trace

""" ﬁ Target Settings
""" Tazk configuration

----- Q Watch- and Recipe Manager
----- '}@ Wiorkzpace

|y (Y oy Y oy R oy R oy RN oy RN e O oy (OO s |

PDUSI B Data t_l,lpesl "»-"isualizatiu:unsl % Hesnurcesl
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Double click the object "PLC Configuration”. If the AC500 folder in the PLC configuration tree is closed,
click on the @ symbol.

File Edit Project Insert Extras Online  ‘Window Help

28| 1B)|@]00F|Ss|So{Gh] /B
Tﬂ—, Resources
B Global Variables
&[] library lecsfe.lib 26.11.02 10:23: 26 global variables
B[ library standard.ib 22.11.02 11:08:30: global variables
2 | library SY'SLIBCALLBACK LIB 23.8.02 16:12:56: global variables
&[] library SvsLibbem lib 29.8.02 16:12:56; global variables
B[ library SysLibTime. b 29.8.02 16:12:58 global variables
B[] library SysTaskinfo.lib 29.8.02 16:12:58: global variables
B[ fibwary LD 12.2.04 12:39:58: global variables
b (5] Tools
Alarr configuration
Library banager

----- Sampling Trace

----- ﬁ Target Settings

----- Tazk configuration

----- Qb Whatch- and Recipe Manager

""" ‘}@ Whorkspace

IIO-EILIS[FI}“U
: InterfacesFlx]
....... @ Couplers[Flx]

First the 1/O devices connected directly to the 1/O bus of the CPU will be entered: Click on "I/O-Bus[FIX]"
and then press the right mouse button.

------- o Interfaces(FI]
------- gl Couplers(FIx

Inserk Element

append Subelement k
Replace element

alculate addresses

Export module. ..
Import module, ..

ZLk ]+
Copy k|12
Paste ZEE[ Y
Delete [el
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Select "Append Subelement" -> "DC532".

: o Interfaces(Flx]
------- @l Couplers(Fi

Insert Element I

append Subelement
Replace element
Calculate addresses

Export module. .

=

kodule parameters |

In... | Marme
1 Fun on config fault

DIS24 - 32 digital Input. ..

532 - 16 digital Input and 16 digital Inoutput. ..
D522 - 8 digital Input and 8 digital Oukpuk (R, ..
%531 - & digital Input and 4 digital Oukpuk (R, ..
Ax522 - 8 analog Input and & analog Oukpuk, .,

Impart module, .

Zuk ]+
Copy Ckrl+iC
Paste Zhr{
Delete mel

Repeat this procedure to append the analog module AX522.

— CPU parameters[FIx]

Module paramete

i

B [ 0-Bus{Fix]

Insert Element

Append Subelement
Replace element
Calculate addresses

------- DiZAa32 - 16 digital Input and 16 digital InoutputPAR]

DIS24 - 32 digital Input...
DC53Z - 16 digital Input and 16 digital Inoukput, .,
D¥522 - & digital Input and & digital Oukput (R, .

Excport module, ..
Impart module, ..

D531 - & digital Input and 4 digital Oukpuk (R, .
? - & analog Input and 8 analog Oukput. ..

- (= CPU parameters[Flx]
- [ N0-Bus[F 1]

Zuk Tkl
Copy CErlHiC
Paste o
[Delete el
=~ EjAca00 |

DCA32 - 16 digital Input and 16 digital InoutputPAR]

------- @l Couplers[FIx]
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Now we are going to append the PROFIBUS DP communication module. In the configuration tree, click
on "Couplers[FIX]" and then press the right mouse button. Select Append Subelement -> CM572 and
then click to append the element.

......... cpu pararmeters[Flx)

& [ NO-Bus [F 1]

DC532 - 16 digital Input and 16 digital InoutputlyAR]
[ A¥522 - 8 analog Input and & analog Output[vAR]
o InterfacesFIx]

-

. @ gcuuplers[Fl}ﬂ

Inserk Element

append Subelement External - none. ..

Replace element CMS7Z - External-PROFIELS DP Master., .

Calculate addresses CMS77 - External-Ethernet, .,

Expart module, ..
Import module. ..

CM573 - External-CaMopen. ..
CM575 - External-Devicehlet, ..

ik L
Copy Chrl+C
Paste (i
Delete el

The coupler is appended to the tree. As the CPU also comprises an integrated Ethernet coupler we are
going to replace ‘Couplers — Internal none’ by an Ethernet coupler.

Bl g INterfaces(Flx]
- @ Couplers[FIx]

-

Hnternal - nane[SLOT] _

- Imsert Element IS DF MasterfAR]
fppend| Subelement
Feplace element Internal - none

Calculate addresses PMSx1-ETH - Internal-Ethernet

Export module. ..

PMSx1-ARC - Internal-ARCHET

Impark module,

Zuk ]+
Copy Chel+C
Paste ZEr] Y
Delete el

Bl o INterfaces(FIx]
- ﬂ Couplers[FIx]

ETH:

------- g PMEx1-ETH - Internal-Ethermet[5LOT]

b [l GMST2 - External-PROFIBUS DP Master[vAR]
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Configuring the decentralized S500-FBP I/O station using the SYCON.net fieldbus
configurator

Now we are going to configure the decentralized S500-FBP I/O station. Proceed as follows:

¢ In the left-hand window, click on the E symbol in front of the Tools entry. Then double click the
entry SYCON.net.

* The SYCON.net fieldbus configurator is opened. Using this configurator, you can configure the
decentralized 1/O station.

Resources

-] Global Variables
| library lecsfc lib 26.17.02 10:23:26: global wariable
-3 library standard.ib 22.11.02 11:08:30: global vana
=[] library SYSLIBCALLBACK.LIE 29.8.02 16:12:56: o
~[E3 library SyzLibbdem lib 29.8.02 16:12:56: global war
-[Z3 library SyzLibTime. lib 29.8.02 16:12:58: glabal war
-3 library Sy=T azklnfo b 29.8.02 16:12:58: global va
-3 library LB 12.2.04 12:33:58: global variables

et

” File Wiew Device Metwork Help

[EEt=%"

* - * - I:l CAMNopen
all [ Project: ﬂ 1 -] DeviceNiet
I
: o) |8
fiE} =
S| Ll ' ; _
=l
T | ®f Metwork T 4] | r [ [}, vendar®, Fieldbus ¢DTM Class /

In the "Fieldbus" tab, open the folder ‘PROFIBUS DPV 0' by clicking on the E symbol. Do the same with
file "Master". With the left mouse button, click on CM572-DPM. Keep the left mouse button pressed and
drag the object into the left window to append it to the green line (this line represents the connection to
the CPU). Release the left mouse button.
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In the appearing window, leave the "Board No. 1" unchanged (counting mode: CPU-internal coupler =
Board No. 0, first coupler left of the CPU = Board No. 1, second coupler = Board No. 2).

x
4

| netDevice

4 |

CMS7 2-DPM[CH

netConneck-Driver Param El

Device:

-1 CaMopen

-0 DeviceMet

-2 Ethernet

=1-[Z3 PROFIBUS DPY O
=-[L1] Master

----- (M5 72-DPM:

-] Slave

|EM 572-0OPM[CME72-DPM]<T=(H1], Slat 7

Board No.: -

Accept I

Cancel |

Fieldbus

Click on "Accept". The coupler is now connected to the CPU.

DPM1 ACSOO[CMS72-DPM]< 1= #1)

Recommendation: You can choose the symbolic coupler name according to your plant (mark coupler
with left mouse button; the coupler is displayed with a blue rectangle; press right mouse button ->

symbolic name. Example for symbolic name: DPM1_AC500).
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The parameter settings of the communication coupler can be easily modified by double clicking on the
coupler symbol (surrounded by a blue line). A window opens - click on "Configuration -> Bus
Parameters". With that you can change the parameters.

Profile: [PrOFIBUSDF 7|

Buz Parameters

Baud Rate: 1z000 - kBitis  Station Address: I 1 ﬁ
Slat Time: 1000 EBik Target Rotation Time: i'n.II I 33430 | LBik

Min. Station Delay Time: 11 LEik 2,7828 ms

LEik GAP Actualization Fackor: I 10

e

o0
=
=

Maz, Skation Delay Time:

Quiet Timme: I g LEik Mazx, Rekry Limik: I 4

Setup Time: I 16 EBit Highest Station Address (HSA): 126
Buz Monitaring

Diata Contral Time: 120 ms [ owerride slave specific Watchdog Contral Time

Min. Slave Interval: 2000 ps WWatchdog Conkral Time: I 200 ms

Calculated Timing
Tidl; TG ms

Tidz: 800 ms Yalues marked with this symbol should be Adjust
adjusted to changes in the topology,

:

[ Auta Clear ON

Ik I Cancel Sl | Help |

Change the desired parameters and then click OK.

The same procedure is used to append a slave to the PROFIBUS DP master CM572-DPM. Open the
"Slave" folder in the "Fieldbus" tab. Drag the PROFIBUS DP FieldBusPlug PDP22-FBP (DPV1 modular)
into the left-hand window to append it to the purple line (this line represents the PROFIBUS DP fieldbus).

[:l CAMapen
[:l DeviceMet
[:l Ethernet
=] PROFIBUS DPY O
I:l Masker
ElI:l Slave
-8 07 KT 97-DP3
-8 07 KT 95-DP3
----- @ DXs01
----- @ DHs02
-§4) PDP21-FBP
PDPZZ-FBP (DPY1 modular)i
PDP22-FBP (V1)

ar [~ Yendor %, Fieldbus /DTM Class 7
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The FieldBusPlug slave is now appended to the PROFIBUS DP line. The symbolic name has been
changed to DPS2_FBP_S500.

DPM1_ACSOO[CMS72-DPM]<1=(#1)
-

DPS2 FEP_SSO0[PDPZ2-FER (DPY1 modular)]<2=

@

i i =

The slave has to be correctly software configured and mapped to precisely match the true hardware
configuration. Double click on the PDP22-FBP symbol to open a new configuration window. In this
window the hardware configuration is described and some parameter settings can be defined.

:netDE\ricE - Configuration DPSZ_FBP_S500[PDPZZ-FBP {DP¥1 modular)]<2 =

@ IO Device: FPDFPZ2-FBP (DPY1 Device 1D
L % Vendar: ABE Mendor ID:

4 Configuration
Station Address: I z

Modules
Parameters V' Watchdog contral

Graups
Exkensions
DPwl

a Dervice Description
Device

G50

Interval; 200 ms
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The slave station has to be set up. Click on "Configuration -> Modules" in the '‘Pages Tree View'. First
select the FBP interface module DC505-FBP from the list of available modules. Click on "Append". Thus
the selected module is added to the list of configured modules.

&vailable Modules:

Configured Maodules:

Maodule name | Module Configuration Identifier | -
DCS05-FBP Ox11,0x20

DISZ4 Ox13

D552 Ox13,0x21 b
D531 0x10,0x20

D522 010,020

AxS22 Ox57,0x67

ACS22 Ox57,0x67

AI523 O 5F

Insert |

Slak | Module name | Module Configuration Identifier |
1 DC505-FEP 0x11,0x20
Length of inpukfoukput data: 3 bykes (max, 488 bytes) Remove |
Length af inpuk daka: 2 bykes (max, 244 bytes)

Length af aukput data:
Mumber of modules:

1 bykes (max, 244 bytes)
1 (max, 8)

A ATTENTION

The order of the modules in the list of configured modules must match the actual
order of hardware modules. Otherwise, the decentralized station and the
network cannot work properly!

G1

Introduction to AC500 1-108 AC500 / Issued: 07.2006



Repeat this procedure to append the modules DC532 and AX522. Then, the list of configured modules
looks as follows:

&vailable Modules:

Maodule name | Module Configuration Idenkifier | -

DCS05-FBP Ox11,0x20

DISZ4 Ox13

D552 Ox13,0x21 b
D531 0x10,0x20

D522 010,020

AXSZ2 Ox57,0x67

ACS22 Ox57,0x67

AIS523 0x5F d|

Insert | Append I

Configured Maodules:

Slok | Module name | Module Configuration Identifier |
1 DC505-FEP Ox11,0x20
z D552 0x13,0x21
] AR522 0x57,0x67
Length of inputfoutput data: 41 bytes (max. 488 bykes) Remoye
Length af inpuk daka: 22 bykes (max, 244 bykes)
Length af aukput data: 19 bykes (max, 244 bytes)
Mumber of modules: 3 (max, 8)

Proceed as follows to configure the module parameters. Click on "Configuration -> Parameters". Select
the corresponding module from the list.

Module: Common j Display mode: Hexadecimal j

Carman
DiZ505-FEP

Parameters;

Mame Yalue |
Block-Parameter Use Block-Parameters
Diagnosis Format DPY0 Diagnosis Formak

Click on the corresponding module.
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The available parameters are displayed.

Maodule: IDCSSE j Display mode: Hezxadecimal j
Parameters:

Mame | ‘alue |

Check. Supply ol

Input Delay 8 ms

Detect shark circuit ak oukpuks oM

Behaviour oukputs at Skop CIff

Substitute value outputs 00000

Example: Changing the input delay of the module DC532.

Maodule: IDCSSE j Display mode: Hezxadecimal j
Parameters:

Mame | ‘alue |

Check. Supply ol

Input Delay 8 ms

Detect shark circuit ak oukpuks oM

Behaviour oukputs at Skop CIff

Substitute value outputs 00000

Highlight the line of the desired parameter: move the cursor to that line and press the left mouse button.

Double click with the left mouse button onto the highlighted line. Click with the left mouse button on EI
to display the values available. Select the desired value by clicking with the left mouse button on that
value. Click with the left mouse button into the area with the empty lines. Thus the change has been
adopted.

After you have changed all the desired parameters, click on OK to exit the parameter configuration.

The configuration of the fieldbus modules is finished. Now the names of the communication variables
used for data exchange between coupler and CPU program have to be specified. Proceed as follows to
specify the variables (these variables are automatically forwarded to the AC500 Control Builder software
in order to have them available there):
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The upper part of the netConnect area contains a tree structure showing the master communication
coupler CM572-DPM and the slave PDP22-FBP (DPV1 modular) with the sorted list appended. Click on
the E symbol in front of the entry PDP22-FBP to open this branch of the tree. For each I/O module, a
separate folder is displayed containing the corresponding data exchange variables.

" || =3 Project: Test3)
50 DPMI_ACS00[CME7Z-DPM]<1 B(#1), Siat 1
=k} DPS2_FEP_SSO0[PDP22-FER (DPY1 modular)] <2
----- 5 brvbe input
----- 14 byke input
----- 27 & woard input
----- 1 brybe oukput
----- 5 brvbe oukput

..... [ & word output

Mame of signal | Daka tvpe | Ij | Mame of variable

| netConneckt

4| » s all signals ¢ Unconnected signals Y, Connecked signals /

Click on the first folder 2 byte input. This folder represents the digital inputs of the DC505-FBP module
(8 DI + 8 DC as input). The corresponding variables are listed in the appended list (with Name of signal,
Data type, I/O identifier (I = input, O = output) and Name of variable (can be entered)).

Ea Project: Test3 =
= ﬂ DPM1_ACSO0[CMS72-DPM]<1=(#1), Slat 1
EENY DPSZ_FBP SSDD[F‘DF‘ZE -FBP (DPY1 modular)]<z >

----- [_ 2 byte output b

----- [ & word autput LI
rame of signal | Caka byvpe | I,I'C| | Mame of variable
I|'||:|L|t 1 EWTE by DDSZ So00_[C505_In0_7
[_ v Dps2 S500_DCSOS Ind 15

a
[u]
i)
=
=
(]

=

4| ¢ [ &l signals /Unconnected signals %, Connected signals

nek.

Enter a corresponding “Name of variable“ for each “Name of signal” .To do this, double click into the
Name of variable field of the corresponding signal. Enter the desired variable name and press the
<Enter> key to complete your entry. These names are used in the AC500 Control Builder software. In
our example, we use the following system for the variable name:
bytePROFIBUSDpslaveAddress2_S500(system)_DC505(device)_Input8_to15 (by - byte; b - bit; w -
word).
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Recommendation: For the planning of your plant we recommend to use symbolic names according to
your plant.

Assign a name to each variable. For the 8 DC (as outputs) of the DC505-FBP module:

neky

nneck

Ea Project: Test3
Eﬂ DPML_ACS00[CMS72-DPM] <1 =(#17, Slat 1

=k DPS2_FEP_SSO0[PDP22-FEP (DPY1 modular)] <2
----- (& 2 bryke input

Marne af signal Daka k I Mame of wariable
_ kD 00 _DCS0S_Ouks 15
: 2
4| ¢ | All signals / Unconnected signals %, Connected signals

For the 16 DI + 16 DC (as inputs) of the DC532 module:

a
[u]
IE]
=
=
(]

nek;

E‘a Project: Test3
E) DPMI_ACS00[CMS7Z-DPM]<1=(#1), Slot 1
=ik} DPS2_FEP_SSO0[PDP22-FEP (DPY1 modular)] <2

Mame of signal | Daka tvpe | I/ | Mame of variable

Input_1 BYTE I byDpsZ_S500_[532_In0_7
Input_2 BYTE 1 byDps2_S500_DCS32 InG 15
Input 3 EWTE I:uprsz_SSEIIZI_DCSSE Ini6 23

-

: 2
4| ¢ | All signals / Unconnected signals %, Connected signals
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For the 16 DC (as outputs) of the DC532 module:

onneck

nekZ

E'a Project: Tests

=) DPMI_ACSOO[CMS72-DPM]<1={#1), Slot 1
=k} DPS2_FEP_SSO0[FDP22-FEP (DPY1 modular)]<2:>

----- =2 byke input

----- [=] 4 byke input

4[ ¥ [ all signals

Inconnected signals

Mame of signal | Data tvpe | I | Mame of variable
Output_1 EYTE o] bprsZ SSEIEI DC532 OutlE- 23

Connected signals

For the 8 analog inputs of the AX522 module:

s
]
m
=
=
(]

nekz

E'a Projeck: Tests

E-f) DPMI_ACSOO[CMS72-DPM]<1=(#13, Slot 1
=-{k) DPS2_FEP_SSO0[FDP22-FEP (DY modular)] <2

----- S bryke input

Mame of signal | Daka bype | I | Mame of variable
Input_1 WORD I whips?_ 5500 _AXS2Z Inl
Input_2 WORD I whips2_5500_ANS22 InZ
Input_3 WORD I whips? 5500 _AXS22 In3
Input_4 WORD I whips? 5500 _AXS22 Ind
Input 5 WORD I whips? 5500 _AXSZ2 IS
Input_& \WORD I whips2_5500_Ax522 InG
Input_7 WORD I prsZ SSEIEI F'.K522 _In7
WORD

4

4[ » % All signals

Unconnected signals

Connected signals

G1

Introduction to AC500

1-113

AC500 / Issued: 07.2006



For the 8 analog outputs of the analog module AX522:

E'a Projeck: Tests
E-f) DPMI_ACSOO[CMS72-DPM]<1=(#13, Slot 1
=-{k) DPS2_FEP_SSO0[FDP22-FEP (DY modular)] <2

----- S bryke input
----- (&1 4 bryke input
----- [&] 8 word input

onneck

4

netky

4[ » % All signals

Unconnected signals

Mame of signal | Daka bype | I | Mame of variable

Oukput 1 WORD 0 whips2_S500_AXS2Z Outl
Oukput 2 WORD o whips2_S500_ANS2Z Out?
Oukput_3 WORD 0 whips?_S500_AXG2Z_Ouk3
Oukput_4 WORD 0 whips?_S500_AXS2Z Cubd
Oukput 5 WORD o whips? S500_AXS2Z OutS
Sutput_& WORD o wDpsZ_S500_ANSZZ_ Outs
Oukput 7 WIORD 0 whips?_S500_AXS2Z_Out?

WORD o Z '

Connected signals

After completion of the variables configuration, the fieldbus configuration is finished.

Store the project via “File -> Safe”.

Loading the configuration from SYCON.net to the coupler

Now the configuration has to be loaded from SYCON.net to the coupler CM572-DP. Proceed as follows:

In the netDevice window, click on the coupler to highlight it with a blue frame:

DPM1 ACSOO[CMS72-DRM]< 15 (#1)

Y

DF‘ISE_FEIF‘_SSEIEI[F‘DF‘EE-FEIF' (OPY1 modular)]«<2:=
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Double click on the coupler icon and select "Settings -> Driver -> 3S Gateway Driver".

] Device 1D
& Vendor I

=netDE\ricE - Configuration DPM1_ACSOL =10| x|

150 069E
B -

FPagez Tree-Wiew

5 EE

a Settings

a Driver
Device Assignment

License Codes
4 Configuration

Bus Parameters
Skation Table
Address Table

SN - Cateway Driver

Firrmware Cownload

Current Configuration:

Channel; F 2l _PiC
Driver name: Eerial (R3...

Read Configuration

Gateway Configuration I

Ok, I Cancel Appli Help

Select "Gateway Configuration".

In the Communication Parameters window, you can set the parameters for the communication between

the PC and the PLC (port: serial interface of the PC).

Communication Parameters

— Channels
= Local [Serial (RS 232)

ABB RS232 COMI

B CO1_PC_ karme | value
Fort COkT
Baudrate 19200
Parity MHa
Stop bitz 1
kotorola byteorder ves
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Confirm the settings with "OK". Select "Settings -> Driver -> Device Assignment" and click on "Scan".
The configuration tool SYCON.net searches for PROFIBUS couplers connected to the stated interface.

Scan progress: 212 Devices (Current device: -)

Scan

| Device

| Serial number | Diriver

| Access path

m| | cms7z-op

Access path:

oo0001 36 35 Gateway Driver

I {13C5FEED-EFGD-41CB-85FE-EDEFSREDZETE Slot 1

I

Help

Select the device "CM572-DP" and confirm with "OK". Then press the right mouse button and select
"Connect".

DPM1_ACSO0[CMSTZ-DPM]-:

Canneck

[iscommeck:

Davrlaad

[pload

Configuration. ..
Measured Yalue, .,
Simulation. ..
Diagrostic, ..

Additional Functions  »

Delete

Symbolic Mame. ..

Deyvice Properties. ..
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The coupler entry CM572-DPM is now highlighted in green, indicating that the connection is established:

DRS2_FBR_SSO0[FDP22-FBR (DPY1 modular)]< 1

Press the right mouse button and select "Download".
ATTENTION: To do this the CPU must be in ‘Stop’ state.

Zanneck

Disconneck poT-FER

Configuration. ..
Measured Yalue, .,
SirnulEk o ..
Diagrostic. ..

Additional Funckions  »

Delete

Symbaolic Mame. ..

Device Properties. ..

A safety inquiry is displayed. Confirm with "Yes".

netDevice - DPM1_AC500[CM572-DPM]=<0= =]
If dawriload is dane during bus operation
communicakion bebween master and slaves is stopped,
Lo wou really wank ko download?

Yes Mo
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This downloads the configuration to the coupler. Progress of data transfer is displayed.

netDevice

Dievice: DPM1_ACSO0[CME72-DPM]<0s (#1]

Dowrload rinning. ..

¥ & complete

. |

Cancel |

After the download is completed, SYCON.net has to be disconnected. Press the right mouse button and
select "Disconnect".

Zonneck

Disconneck

Dowwnload
pload

Configuration, ..
Measured Yalue. .
Simulation. ..
Diagnostic. ..

additional Functions  *

Delete

Symbaolic Mame. ..

Device Propetties.. .

LEE-FBF‘ (DPv1 modular )] < 1=

In SYCON.net, the configuration has to be saved to a file. The system adopts the project name (in our
example: "Test3"). Select "File/Save".

= 9YCON.net - [Test3.spj]

” File | Wiew Device Metwork  Help

‘ |ﬁ Save

2 &= =

F Exxit

= <

Exit SYCON. Select "File/Exit".

TISYCOM.net - [Test3.spij]

” File | Wiews Dewice MNebtwork Help

@ e e
F‘l Exit — w—
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Return to the AC500 Control Builder by clicking on the R CoDeSYS | 1100 in the Windows task bar on
the bottom of the screen.

The AC500 Control Builder software is opened again and the fieldbus variables are automatically
transferred to the Global Variables list of the programming software.

Open the Global Variables in the "Resources" tab. Double click on Slot 1 <R>. The previously
configured variables are displayed and available in the programming software.

- 0001 |vAR_GLOBAL
% Resources 0002  byDps1_S800_DCS05_In0_7 AT %IB1.0: BYTE;
B Global Variables 0003  byDpsi_SS00_DCS05_InE_15 AT %1811 : BYTE;
@ Global Variables 0004  byDps1_S800_DCE32_In0_7 AT %IB1.2: BYTE;
. 0008 byDpsi_S800_DCE32_In8_18 AT %IB1.2: BYTE;
@ vaiabl Corfguaton veR CONI ) LR AT w4 BYTE
(2] librany lecsfe lib 26.11.02 10:23:26: glok RSt _=att_ —inte_ - ?
]g Iibrarﬁ oo i 2311 0211-09-33- ; 0008  wDps1_S800_AKS22_In2 AT %1414 WORD;

Anes HEe DL 0008 byDps1_S500_DCS32_In24_31 AT %IB1.5 : BYTE;
-] fibrary SYSLIBCALLBACK.LIB 23.8.02 1| Fygan wDps1_GA00_AXE22_In3 AT %I 5 - WORD:;
-] library SysLibtem ib 23.8.02 16:12:56: o011 wDps1_SA00_AKG22_Ind AT %IW1 6 WORD;
H-[ library SysLibTime b 29.8.02 161258 || (0012  wDps1_S500_&%522_In& AT %0417 WORD:
-] library SysT askinfolib 29.8.02 161258 |0013]  wDps1_S&00_AKS22_InG AT %1 8 WORD;
A library Utilib 12.2.04 12:39:58: global /| 9014 wDps1_S500_ARS22_In7 AT %19 WORD,
1 G Tooks 0018  wDps1_S5800_AKS22_In8 AT %I 10 WORD;
- _ 0016  byDpsi_S500_DCS05_0utd_15 AT %0B1.0: BYTE;

Alarm configuration

0017  byDps1_S600_DCS32_Outl6_23 AT %0E1.1: BYTE;

~ (ff] Libraty Manager 0018  byDpsi_S500_DCS32_Out2d_31 AT %081 2 : BYTE;

""" Bl Log D018  wDps1_S500_AXE22_Outl AT 5011 7 WORD:;

""" (B3 PLLC - Browser 0020l  wDps1_S500_AXS22_0ut2 AT %0V .3 WORD;

""" PLE Configuration 0021  wDpsl_S500_AXG22_Outd AT %001 4 WORD:

----- S ampling Trace D022  wDps1 _S500_AXE22_Outd AT 5011 5 - WORD:

..... & Targe! Setings D023  wDps1 _S500_AXE22_OUtS AT 5011 6 - WORD:;

..... T ask configuration D024  wDps1_S500_AXE22_OUtE AT %011 7 WORD:;

_____ @, wiatch-and Rcipe Manage D028  wDps1 _S500_AXE22_OUtT AT %01 & WORD:;
D026  wDps1_S500_AXE22_OUts AT %011 0 WORD:;

""" '}@ Whorkspace

0027 EMD _WAR

Testing the system

In order to test the system, we are going to create a small user program according to the procedure used
in the Getting Started example. We are using the ST programming language (structured text). The
program should read an input of the decentralized station (DC505-FBP) and output the value to the
DC532 device located next to the CPU. The output byte %QB0 at DC532 (located next to the CPU) is
named with the symbolic name by_AC500_DC532_0Out16_23.

The program looks as follows:

DM |PROGRAM PLC_FPRG
noozfvAR
0O003EMD_WAR

Ooond
T

Q004 by _ACa00_DCa32_outl6_23 = byDpst1 _S5500_DCais_In0_T;
oooz
ooo3

The input byte with the variable name byDps1_S500_DC505_In0_7 (signals 10 to 17 at DC505) is read
and applied to the output byte by AC500_DC532_0Out16_23 (signals C16 to 23 at DC532).
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New GSD file(s)

(?Eg If you install additional GSD files to the installation of the Control Builder CD's
Note GSD files they have to be added to the device catalog of SYCON.net. To do
this apply subsequent procedure.

The GSD files have to be copied to the corresponding directory beforehand
(\ProgramFiles\HilscherGmbH\SYCONnet\ABBPBGenericSlaveDTM\GSD).

Attention: Handling of GSD files only works that way in case of an empty
project!

Click on 320 Resources Open the 'Tools' folder. Double click on the entry SYCON.net.

TE.—, Resources
-] Global Variables
|:| library lecsfe.lib 26.11.02 10;23:26; global variable
B+ library standard ib 22.11.02 11:08:30: global varia
|:| library SYSLIBCALLBACK LIB 29.8.02 16:12:56: ¢
I:I library SysLibbem ib 29.8.02 16:12:56: global war
-3 library SysLibTime.lib 23.8.02 16:12:58: global war
~[E3 library Sy=T asklnfo lib 29.8.02 16:12:58: global va
-[Z3 library LB 12.2.04 12:39:58: global variables
= (5] Tools
P IP config <Ry
@ Maotepad <R

SYCOM. net <Hx

Click into the window next to netDevice and select "Network/Device Catalog..." from the menu.

Metwaork | Help

|@ Device Catalog...
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:I‘IEI:DE\I'iEE - Device Catalog o =]

-] AEB
-7 ABE STOTZ-KONTAKT GmbH

4| » [+ ¥endor ;Fieldbus %, DTM Class

Select a device to show information

[

Reload | ok |

Click on 1&233 This integrates the new GSD file. Click on OK and close SYCON.net.

G1

Introduction to AC500

1-121

AC500 / Issued: 07.2006



For AC1131 experts —
connection S500-FBP I/0 module to series 90

Example with an AC31 Series 90 CPU as PROFIBUS DP Master and a DC505-FBP as

remote 1/0s

0\

+/-24V DC

-— PDA11-FBP.050

220000 | 1 [ ] | | lee (®)

i i i

pee ooe pee oeeo oo eed cee  eoq| E

A3 07 KT 98

AdvantControlle31
BasicUnit
N 1 1 o
©
eee o009 1] 209 (1] o009

O A—

<]

eED e
I

» PC

PDP22-FBP

00002000000 (062000000 200000000| [00000| (@)

07 KT 97/98 DP

] o

@nnn

000000000,

DC505-FBP + DC532 + AX522
-<«— PDR11-FBP.150

Figure: Example with an AC31 series 90 CPU as PROFIBUS DP master and a DC505-FBP as remote

I/Os

The following example will guide you through the installation and the configuration of a small PROFIBUS
DP fieldbus using an AC31 PLC as PROFIBUS DP Master and a S500-FBP remote 1/O station with a

modular FBP.

This example could be used as starting point to realize your own application.

A ATTENTION

Refer to the dedicated User's manuals or Installation guides of the
FieldBusPlug and the AC31 PLCs and programming software.
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Needed products

Quantity

Product description

Order number

1

&

CPU 07 KT 97/98 with PROFIBUS DP
here: 07 KT 97 with Ethernet and PROFIBUS DP
coupler

GJR5 2530 00 R0272

Programming cable 07 SK 90

GJR5 2502 00 RO001

PDA11-FBP.050 adapter for FBP, power supply and
field bus

1SAJ 9240 09 R0005

PDP22-FBP.050 PROFIBUS DP-V0/V1-FBP 0.5 m,
modular (field bus plug)

1SAJ 2401 00 R1005

PDR11-FBP.150 terminating resistor

1SAJ 9240 07 R0O0O01

DC505-FBP with 8DI/8DC

1SAP 2200 00 R0O001

DC532 with 16DI/16DC

1SAP 2401 00 R0O0O1

AX522 with 8AI/8AO

1SAP 2500 00 R0O001

TU506 FBP terminal unit for FBP interface

1SAP 2100 00 RO0O1

TU516 I/O terminal unit for I/O modules

1SAP 2120 00 RO0O1

GSD file for FBP modules

ABB_091F.GSD

FEEEEEEE & EE

Programming software 907 AC 1131

GJP5 2070 00 R0102

Before starting:

Use the previous installation instructions to assemble and mount the system, also refer to the
dedicated User's manual of the PROFIBUS DP FBP and AC31 series 90 PLC.

Make the wiring and provide power supply to the system (process supply) and to the FieldBusPlug
(use dedicated accessory, e.g. PDA11-FBP.050 which allows to connect a PROFIBUS DP master
with a 9-pin D-Sub and provide power supply for the FBP through an M12 connector).

Set the slave address of the FBP to 1 with the front rotary switches of the S500-FBP module (see
Getting Started with S500-FBP, "Setting the FBP slave address").

Install the AC1131 programming software for AC31 PLCs

If you want to configure the fieldbus using the fieldbus configurator software 907 FB 1131, install this
software. As an alternative, you can also use the fieldbus configurator included in the programming
software.

If you want to use the fieldbus configurator 907 AC 1131 for configuration, copy the PROFIBUS GSD
file ABB_091F.GSD to the folder \Program Files\AC1131\FB1131\Fieldbus\PROFIBUS\GSD. If you
want to configure the fieldbus using the fieldbus configurator included in the programming software,
copy the GSD file to the folder \Program Files\AC1131\Library\PLCConf.

e Connect the PC (COM1) to the AC31 CPU (COM1) using the programming cable 07 SK 90.
e Connect the CPU to the DC505-FBP module via the FieldBusPlug.
e Switch on voltage.
e Perform the steps given in the following instructions.
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Variant A: Configuration using the fieldbus configurator included in the
programming software

First, we have to specify the hardware. Click on Ee Resources. Double click the object "PLC
Configuration”. Click on "Hardware Configuration". Press the right mouse button. Select "Append

Sube

lement/DP Master...".

File Edit Project Imsert Extras Online  ‘Window Help

Bl @] E|2E|

&
-
-

Resources Insert Element

3 Giobal Variables Append Subelement

(27 libramy IEC_590 Y41 LIB=11.4.0 Properties...

m] Library Manager

m Log Lk Zh| 3

@ PLC - Browser EDDI:F Etr:"-ﬁ

—— ; Ashe rl+

PLC Configuration

e Delete Del

Sampling Trace
T azk configuration
{% YW atch- and Receipt kM anager

07CR41...
O7CR42, .,
07CT41..,
07CT42...
07kRS1...
O7KTS1...
O7KTI5, .,
O7KTI6, .,
OFKTI?...
O7KTIE. ..
07597 ...
DP-Master...
DP-Slave. ..

Set the "Card number" in the appearing window. The following rule applies: The slot number (= card
number) can be gathered from the identification number of the CPU. Furthermore, we can also
determine the coupler form the identification number. The following applies:

GJR5 253x 00 Rxxyz with
y = slot number = card number = 1
z = slot number = card number =2

Furthermore, the following code applies to y and z: 2=PROFIBUS DP / 5=DeviceNet / 6=ARCNET /

7=Ethernet / 8=CANopen / 9=Interbus

For our example: CPU with identification number R0272 -> slot number 1 -> Ethernet; slot number 2

-> PROFIBUS DP

Since we are using the PROFIBUS coupler in our example, the resulting card number is 2.

Select a PROFIBUS-DP master

ABB STOTZ-KOMTAKT GmbH
[dent-Mr.:  %1.000

Hw Release:  0=7505

SW Release: E

Manufacturer.  ¥4.15
K.T97_DPk.ged

Cancel

File M ame: Card number:
07 KT 97-DPM [Defaull =2
Confirm with "OK".
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Press the right mouse button and select "Append DP Slave".

Insert Element

Append DP-Slave

407 KT 97-DPM [DP-Master]

k

Properties...

Cuk Chrl+3
Copy CErliC
Faste ZhElY
Delete Dl

In the appearing window, select "PDP22-FBP (DPV1 modular) (Default)" in the File Name list box.

Select a PROFIBUS-DP slave

ABE
[dent-Hr: % 1.1

Hiwf Release:  0=091F
5w Feleaze: W 1.0
b anufacturer: % 1.0

&ABB_D31F.GSD

File M ame:

I PDOP22-FBF [DPY madular] [Default)

=~

Cancel

Confirm with "OK".

Propetties. .

Insert DP-Slave
Append Subelement

Cuk
Copy
Paste
Delete

Chrl+3
Chrl+iC
Chrl+y
Dl
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Select "Input/Output”. Click on the entry DC505-FBP in the left-hand window and then click on
"Select >>". Proceed in the same way for DC532 and AX522.

PDP22-FEP {DP¥1 modular) 2=
Eaze Parameters  [nput/Output I Parameter I Groups I
b ax. length of input data: 244 Bute Length of input data: 22 Byte
b ax. length of output data: 244 Bute Lenath of output data: 139 Bute
Max. length of in-foutput data: 488 Bute Length of in-/output 41 Byle
bax. number of modules: a Mumber of modules: 3
= Input M odulesz S_elected bodules
D524 154P240000R 0000 DCB0E-FEF 15AP220000R 0001
Ph5=1 16 byte input DCB32 154AP2401 00R 0007
b PMBT 4 byte input e heB22 15AP250000R 0001
- PMBx1 16 word input
i PMS1 4 word input
= Output Modules << [elete |
= In-/Cutput Modules
- DCROS-FBEP 15AP220000R 000
- DCR32 15AP240100R 0001
- DeeB31 15AP245000R 0001 Froperties
- DeeB22 15AP245200R 0001 —lp
- B2 15 APZE0000R 000
- PR 5=T 16 byteward indoukput
- PR 5E1 16 byte indoutput
- PR 5RT 16 word indoutput
< | 2]
] Cancel

E-—-PDP22-FBF (DPY1 modular) [DP-Slave]

E--iDCA05-FBP 15AP220000R0001

e AT %IB1.0: BYTE,
- AT %IB1 10 BYTE;
b AT %0B1.0; BYTE;
Bl--DC532 154P240100R0001
B--#3(522 1SAP250000R0001

When a user program is loaded to the CPU, the configuration data of the coupler (the data are a definite
element of a project) are loaded as well. The operating system of the PLC transfers the configuration
data to the coupler. In addition, the configuration data can be saved together with the user program in
the Flash memory of the controller. The configuration data stored in the Flash memory are automatically

loaded the next time the power is switched on.

G1

Introduction to AC500

1-126

AC500 / Issued: 07.2006



Variant B: Configuration using the fieldbus configurator software FB1131

Start the fieldbus configurator software 907 FB 1131 and select "File -> New". A window appears where

you can select a fieldbus system.

Select fieldbus

X

CAMopen
DeviceM et

FROFIELIS

0k I
Ethernet / Protocol Cancel |
InterBus

Select PROFIBUS and click on OK. Now you have to configure the master.

Select Insert -> Master from the menu bar. The mouse pointer changes to an arrow with an 'M'. Left
click with the mouse on that position on the screen where you want to place the DP Master. Another

window appears.

Axallable masters

07 K.T 97-DFPk
07 KT 97-DPM
07 KT 97-DPM
07 KT 35-0PM
07 KT 93-DPM
07 K.T 98-DPM
07 5L 37-DPM
07 5L 97-DPM
07 5L 97-DPM
CIFE0-FE

Add s

Add &l

<< Remaove All

<< Remove

ikl

Yendor name  ABB STOTZKOMTAKT GmbH

|dent number 0=7205
G50 file name  KT97_DPM.GSD

Selected masters

Station address I

]

x|
Lok |

Dezcription |

In this window, select 07KT97 DPM and click on Add >> to add the selected master to the network. The
selected master is now displayed on the right-hand side of the window. You can change the default
address of the master and enter a comment in the 'Description’ field.

Axallable masters

07 K.T 97-DFPk
07 KT 97-DPM
07 KT 97-DPM
07 KT 35-0PM
07 KT 93-DPM
07 K.T 98-DPM
07 5L 37-DPM
07 5L 97-DPM
07 5L 97-DPM
CIFE0-FE

Add s

Add &l

<< Remaove All

<< Remove

]

Yendor name  ABB STOTZKOMTAKT GmbH

Selected masters

07 KT 37-DPM

Station addrezs ID

Cancel

x|
] |
_ Carcel |

|dent number 07505 Dezcription |Master[l
G50 file name  KT97_DPR.GSD
Click on OK and continue.
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T'E_g File Edit Wwiew Insert ©Cnline Settings Tools ‘Window Help

0@ %] 2]
|| %% oo
1= &
‘m — MasterQ
L Station addrass ]
OF Master a7 KT 97-DFP M

Now append a slave to the PROFIBUS DP line. Click below the master surrounded by a frame. A
rectangle indicates the area where the slave will be inserted.

Select Insert -> Slave from the menu bar.

Insert

Master. ..

online  Settings  Tools  Window  He

Communication Reference conneckion, ..

Predefined Slave. ..

The mouse pointer changes to an arrow with an 'S'. Proceed as already described for the master in
order to place the slave. A new window appears.

Left click with the mouse on that position on the screen where you want to place the Slave. Another
window appears. Scroll down in the left-hand area and select PDP22-FBP (DPV1 modular) as the
slave. Then click on ADD >>. Your selection is displayed on the right-hand side of the window.

— Slave Filter

Vendar Al

Master {0 /07 KT 37-DPM

Slave type I.-’-'-.II

Axalable zlaves

Selected zlaves

| IIIKl
Cancel |

D501
D=5
Da0
D502
C=5602
D602
FOP21-FEP
FOP22-FEP

FOP22-FEP [DF%T madular]

Yendaor name
Ident nurmber
G50 file name
G50 Revision

Add x> PDFZ2-FEF [DFY1 modular)

[
[
4]

Add &l =

<< Remove All

fEEE

<< Remove

ABRE Station addrezs I1

O«091F Description |S lave
ABB_091F.GSD
W11

In this window, you can also change the default station address and enter a description for the device.
Then click on OK.

G1

Introduction to AC500 1-128

AC500 / Issued: 07.2006




The configured fieldbus is displayed.

lf_g File Edit “iew Insert Online Settings Tools  Window  Help

O|(d| &

d

| =in] % Poo

I..“
I:I?KTEI?-DPM ———
[

Mastero

OP Slave

Station address 1]

DP Mastor O7F KT 97-DF I
FBF@ Slave

Station address 1

FPDP22-FBP (DP%1 modular)

Double click inside of the rectangle surrounding the slave in order to configure the slave. A new window

named Slave Configuration appears.

Slave Configuration

General
Device

Dreszcription

FOP22-FBP [DFYT madular)

Station addrezs

I.I_

IS lavel

¥ Activate device in actual configuration

¥ Enable watchdog control G50 file ABE_031F.GSD
b aw. length of in-/output data 438 Bute Length of in-/output data 3 Bute
bdax. length of input data 244 Bute Length of input data 2 Bute
bdax. length of output data 244 Bute Length of output data 1 Eute
bl ax. number of modules a Murmber of modules 1
Module Inputs |Outputs|In/0ut |Identifier -
DOS05-FED ? Byte 1 Byte Oxll, 0x20 ||
15APZZ0000R0O001
DILZ4 13APZ40000RO0COL 4 Byte Oxl3
DCLz2z l1saPz401l00R0O0O01 4 Byte £ Byte Oxlz, O0xZl
DiE&31l 15aPz4L000ROOOL 1 Byte 1 Byte Oxl0O, OxzZ0 -

OF.

Cancel

Parameter Data...

D Settings...

—Azzigned master
Station address 0

bl azterd

0/ 07 KT 37-DFPM

—Actual lave
Station addreszz 1

Slavel

|1/ PDP22FBP [DPY1 moc = |

Slot|Idx [Module

Bymhol

|Type [T addr [T Len. [Type|0 addr [0 Len.

u] 1
u] E

DCEOE-FB Modulel IE
DCEOE-FB Modulel

0

E
QE 0

il| Append Module I

Remove Module |

[nzert Module |

Predefined kodules |

=l

Symbalic Mames |

The modular station has to be configured in order to specify the used hardware. First, select the FBP

interface module DC505-FBP (list of available modules ('"Module' column) in the window shown above;

the selected module is highlighted by a rectangle). Click on Append Module to insert it into the list of

configured modules.
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The following information is given for the selected modules: Slot number (Slot), module type (Module)
and definition of the input bytes/words IB/IW and the output bytes/words QB/QW. Then we have to
specify the expansion modules of the used hardware. In our example this is a digital input/output module
DC532 and an analog input/output module AX522.

After you have added all required modules into the configuration list, click on OK to apply the

configuration.

o
eneral
Device PDP22FBP [DFY1 madular] Station address |1 Ok
Deszcription ISIave1 Cancel

W Activate device in actual configuration

Parameter Data...

¥ Enable watchdog control G50 file ABE_091F.GSD
Mazx. length of in-doutput data 488 Byte Length of in-Aoutput data 41 Byte DPY1 Settings...
b, length of input data 244 Bute Length of input data 22 Bute ~ Assigned master
bl . length of output data 244 Bute Length of output data 19 Bute Station address 0
bax. number of modules a Mumber of modules 3 b asteri]
Module |Input5 |Elut,put,s|In,-"EIut, |Identi fier - ID 07 KT 97-DFM j
DHEZ]l 1SAPZ45000RO0O01 1 Eyte 1 BEyte Oxl0, Oxz0
J —Actual slave
DMEZZ LSAPZ452Z00R000L L Byte 1 Evte Oxl0, Ox20 [ —1
Slavel
AWEEEZ 1SAPZE0O000ROOOL 8 Word & Word Ox&7, Ox&7
|1/ PDP22FBP [DPY1 moc x|
w
2lot|Idx [Module [Symbol [Type|T iddr. [T Len. [Type[0 addr. [0 Len. |2 [ AppendModile |
u] 1 DCEQOE-FE Modulel IE a Z
o z DCE05-FE Modulel QE ] 1 Remove Maodule |
1 1 DCEZE HModulez IE u} 4 |  Modul |
1 Z DCE3E Modulez QE u} Z nisert Mool
z 1 Ax5ZZ Hodulez I 0 8 Fredefined Modules |
Z Z BHEEZE Modules T u] 2

Symbolic Mames |

=

Call the address table before you specify the parameter data (via View -> Address Table) in order to
update the addresses of the input/output variables.

If you want to change the device parameters of the slave, select the device entry to highlight it by a
rectangle. Press the right mouse button and select Parameter Data from the context menu.

K a
m Master0
I— Station address ]
DP Master 07 KT 97-DP M
FEP@ Slave1
Station aciress 1
0P Slave FODP22-FBP (DPY  modular)
Zuk Ckrl+
Copy Chrl+C
Paste (| o
Delete Ckrl+L
Replace Ckrl+R
Slave Configuration. ..
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A new window appears, showing all PROFIBUS DP parameters:

Parameter Daka

Dezcrption All Parameter Data in hex descrption
Byte  (Description W allie
I} 1 parameter data byte =30
1 2 parameter data byte Q=00
2 3 parameter data byte Q=00
3 4 parameter data byte Q=00
4 5 parameter data byte Q=00
5 G parameter data byte Q=00
G ¥ parameter data byte Q=00
i 3 parameter data byte Q=00
a 3 parameter data byte Q=00
9 10 parameter data byte =
10 11 parameter data byte =
11 12 parameter data byte O=F4
12 13 parameter data bute Dy

OF.

Cancel

Parameter Data
Cormmat

b odule

HiE e

For instance, click on Module if you want to change the delay time of all inputs of the module DC532.

Select Module

DCEOS-FEP 1542200008 0001
DCR3IZ 154P240100F 0001
AxB22 15AP250000R 0001

Cancel

x|
ak. I
L

Select de532 1sap240100r0001 and click on OK. The corresponding module parameters are displayed

and can be changed now.

Parameter Daka

Diezcription Index Parameter Data

Byte |(Description W allie

0 101D DCR32

2 |0 Parameter Length T Butes

3 Check Supply 0

4 |nput Delay a3 mz

] Fast counter Mo counter
G Detect short circuit at outputs 0

¥ Behaviour outputs at Stop aff

a Substitute value outputs 0

OE.

Cancel

Parameter Data

Cammat

HiE R}

b odule

Example: In order to change the delay time of the inputs, double click on Input Delay.
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A new window appears, showing all available values. Select the desired value, e.g. 1 ms, and click on

OK.

Input Delay

x|

| 0.1 ms | k. I
Cancel |

a3 mz
32 mz

The new value is

applied.

Parameter Daka

Ok

Cancel

Parameter Data

D escription Index Parameter D1ata

Byte |Description " alue -
1] [ DCh32 (I
2 |0 Parameter Length 7 Buytes

3 Check Supply M

4 Input Delay 1 ms

5 Fazt counter Mo counter

B Detect short circuit at outputs M

7 Behawviour outputs at Stop (ff

2 Substitute value outputs 1]

Cormmar

tadule

i R}

After you have changed all the desired parameters, click on OK to exit the parameter configuration. The
following configuration is displayed:

?'E_: File Edit “iew Insert Online Settings Tools  Window  Help

0= | =] 2]
| =] %[ oo
i a
wm?.m — MasterD
i Station address 1]
DP Mastor O7F KT 97-DF I
FBF@ Slave
Station address 1
DP Slave FOP22-FEP (DPY1 modular)
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In order to test the configured fieldbus, the configuration has to be downloaded to the master. Select the
master (click on the master to highlight it by a surrounding rectangle). Select the menu item Online ->

Download.

Orline  Settings  Tools  Window  Help

Download., .. Ckrl+D

Stark Debug Mode

Device Diagroskic, . .
s Diagmostic, ..

Firrmmare Download. ..

Firmware [ Reset, .,

Extended Device Diagnaoskic, ., Chrl+T
Global State Field. ..

Liwe Lisk. ..

M Mamitar, ..

Automatic Metwark Scan. ..
GEel Dhjeck dickionary
Sef slave Address, .,

Skart Cornrmunicakion. ..
Stop Cornmunication. ..

Device Infa. .,

Read Project Information. ..

Select 3S Gateway Driver as gateway for the download to the CPU coupler and click on OK.

Driver Seleckt

Vendar 35 GmbH
Werzion V2.0

D ate 18.07. 2002
Functions 5

Cancel

X
35 G ateay Diriver ok,
CIF TCP/IP Driver _
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A new window named 3S Gateway Driver Assignment is opened for setting the gateway parameters
for the address assignment of the DP coupler in the CPU (this is only done when the gateway is used

the first time).

35 Gateway Driver Assignmenkt

— Gateway Configuration

Channel I

[3 ateway Configuration |

Drriver Mame I

X
IIIKI
=

Canicel

— Device Information

Name Type Wersion

[rate

Connect

L R B

Click on Gateway Configuration and then select the default channel COM1_PC in the appearing

window.

Communication Parameters

— Channels

=) Lokal 4BB RS232
g CLIk1_PC

Ok

M arme | W alue | Comrment

dik

I Cancel

Port COm1
Baudrate 13200
Parity Mo
Stop bitz 1

Mew ..

Remove

Gateway ...

Ilpdate

E

Apply the selection by clicking on OK.
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The window is closed and the software tries to establish the connection via the gateway. If the
connection establishment is successful, the couplers are displayed in the Device Information area.

- Device Information
Name Type Wergion  Date Error
Slat 0 = IENEIMB IF'ME:HETH ITEI'I.EISEIa |u?.n?.05 |n Connect |
Slat 1 IDF"M IEME?E-DF" ITEI‘I.EIEIF" |24.|32.|35 |n
slot 2™ | | | | |a03
Slat 3071 | | | | |403
st 4 | | | | [403

Click into the field next to the coupler name to select the desired coupler (DPM) and confirm with OK.

To perform the download, select the menu item Online -> Download. A safety inquiry is displayed.
Answer with Yes. The configuration is then transferred to the controller.

The address data used can be displayed using the menu item View -> Address Table.

View Insert Online ¢

Device Table. ..
Address Table, ..

ZRL Takle...
Gl Tiakle, .

Toolbars »
v Status Bar

The digital inputs can be accessed via IBO to IB5, the digital outputs via QB0 to QB2 and the analog
outputs via QW3 to QW11.

R
s
g
B

Station addresz 0 ||:| 07 KT 97-DPM j Ok

Dezcrption M azterl

addr. [Slot|ldx. [Device [t odule |Symbol name || Type [l &ddr. [ Len. [0Type|0 Addr. [0 Len, [«
2 0 1 PDP22-FEF [DF DCRO5-FEP Modulel IB 1] 2 |
2 o2 DCRO5-FEP Modulel Qe 0 1

2 1 1 DCR32 Module2 IB 2 4

2 1 2 DCR32 Module2 ne 1 2

2 2 1 AxRZ2 Module3 v B a

2 2 2 AxRZ2 Module3 w3 a

Sort according ta station addreszes Sart according to data addresszes Address Overview. .
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Testing the system

In order to test the system, we are going to create a small user program. We are using the programming

language FBD. The program should read an input of the decentralized station (DC505-FBP) and output
the value at the CPU. The program looks as follows:

0001[FPROGRAM PLC_PRG
Qo00z/var
Q003END VAR

nond
T

0ao1

WIBZ.0——%0B124

The first byte on the DC505-FBP is read at address %IB2.0 and output at the CPU via the address
%QB124 (outputs A62,00 to A62,07).
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